THESIS

JOINT DEPLOYABLE INTELLIGENCE SUPPORT SYSTEM (JDIOUS) COMMUNICATIONS AND IMAGERY APPLICATION GUIDE FOR NEW USERS

by

Marlon F. Brown

June 1997

Principal Advisor: Gary R. Porter

Approved for public release; distribution is unlimited.
# Joint Deployable Intelligence Support System (JDISS) Communications and Imagery Application Guide for New Users

**Marlon F. Brown**

**Naval Postgraduate School**
Monterey CA 93943-5000

The views expressed in this thesis are those of the author and do not reflect the official policy or position of the Department of Defense or the US Government.

Approved for public release; distribution is unlimited.

The purpose of this thesis is to provide a Joint Deployable Intelligence Support System (JDISS) Communication and Imagery Application Guide for New Users. These two applications, together, are the core of the JDISS program. Both applications were examined to identify functions and processes that are difficult to understand as well as functions and processes that lack sufficient instructions for new users. The supporting JDISS Desktop and Utilities applications were added to provide the knowledge base required for the new user to use the Application Guide as a stand-alone document. Other JDISS applications, such as Office Tools, E-mail, Intelink, etc., are not included due, in part, to a common thread with other programs that the new user should already be familiar with, but mostly due to the adequate help instructions readily available within the JDISS main desktop help function.

The JDISS program was developed to ensure that each of the U.S. Services and Agencies had an integrated intelligence system, and one that would provide a common data standard permitting interoperability both intra-service and inter-service. The Joint Staff, Director of Intelligence (J2), has highlighted JDISS in joint doctrine as the principal intelligence component for interoperability (JBOC, 1996). Therefore, this detailed, step-by-step JDISS Communication and Imagery Application Guide for New Users was developed and designed to help future JDISS users worldwide.

**Subject Terms**

16. **Price Code**
UL

<table>
<thead>
<tr>
<th>Security Classification of Report</th>
<th>Security Classification of this Page</th>
<th>Security Classification of Abstract</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unclassified</td>
<td>Unclassified</td>
<td>Unclassified</td>
</tr>
</tbody>
</table>

Standard Form 298 (Rev. 2-89)
Prescribed by ANSI Std. 239-18
JOINT DEPLOYABLE INTELLIGENCE SUPPORT SYSTEM (JDISS)
COMMUNICATIONS AND IMAGERY APPLICATION GUIDE FOR NEW
USERS

Marlon F. Brown
Major, United States Marine Corps
B.S., Southern Illinois University, 1986

Submitted in partial fulfillment of the
requirements for the degree of

MASTER OF SCIENCE IN SYSTEMS TECHNOLOGY
(COMMAND, CONTROL AND COMMUNICATIONS)

from the

NAVAL POSTGRADUATE SCHOOL
June 1992

Author: Marlon F. Brown

Approved by: Gary R. Porter, Principal Advisor

Tim Phillips, USMC, Associate Advisor

Dan C. Boger, Associate Advisor,
Chair, C4I Academic Group
ABSTRACT

The purpose of this thesis is to provide a Joint Deployable Intelligence Support System (JDISS) Communication and Imagery Application Guide for New Users. These two applications, together, are the core of the JDISS program. Both applications were examined to identify functions and processes that are difficult to understand as well as functions and processes that lack sufficient instructions for new users. The supporting JDISS Desktop and Utilities applications were added to provide the knowledge base required for the new user to use the Application Guide as a stand-alone document. Other JDISS applications, such as Office Tools, Email, Intelink, etc., are not included due, in part, to a common thread with other programs that the new user should already be familiar with, but mostly due to the adequate help instructions readily available within the JDISS main desktop help function.

The JDISS program was developed to ensure that each of the U.S. Services and Agencies had an integrated intelligence system, and one that would provide a common data standard permitting interoperability both intra-service and inter-service. The Joint Staff, Director of Intelligence (J2), has highlighted JDISS in joint doctrine as the principal intelligence component for interoperability (JBOC, 1996). Therefore, this detailed, step-by-step JDISS Communication and Imagery Application Guide for New Users was developed and designed to help future JDISS users worldwide.
# Table of Contents

I. **INTRODUCTION** .................................................................................................................. 1

II. **JDISS PROSPERITY** ........................................................................................................ 5
   A. JDISS YESTERDAY ............................................................................................................. 6
   B. JDISS TODAY .................................................................................................................. 7
      1. JDISS Applications ....................................................................................................... 8
         a. Communications ....................................................................................................... 9
         b. Email (Electronic Mail) ............................................................................................ 11
         c. Office Tools ............................................................................................................. 11
         d. Images ................................................................................................................... 12
         e. Utilities .................................................................................................................. 13
      2. JDISS Automatic Dissemination .................................................................................. 14
         a. Pull Architecture ..................................................................................................... 14
         b. “Smart” Push ........................................................................................................... 15
         c. Advantages ............................................................................................................ 16
      3. JDISS Client-Server Environment (CSE) ..................................................................... 16
         a. Stand-alone Workstations ....................................................................................... 17
         b. Client-Server Workstations .................................................................................... 17
         c. JDISS Growth ......................................................................................................... 18
   C. JDISS TOMORROW ......................................................................................................... 18

III. **SUMMARY** .................................................................................................................... 21

APPENDIX A: JOINT DEPLOYABLE INTELLIGENCE SUPPORT SYSTEM (JDISS) COMMUNICATIONS AND IMAGERY APPLICATION GUIDE FOR NEW USERS .................................................................................................................... 23

APPENDIX B: JOINT DEPLOYABLE INTELLIGENCE SUPPORT SYSTEM (JDISS) WORKSTATIONS REQUIREMENTS AND PERIPHERALS .................................................................................................................... 25

LIST OF REFERENCES .............................................................................................................. 27

INITIAL DISTRIBUTION LIST .................................................................................................. 29
# LIST OF ACRONYMS

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACOM</td>
<td>Atlantic Command</td>
</tr>
<tr>
<td>ADP</td>
<td>Automated Data Processing</td>
</tr>
<tr>
<td>AIM</td>
<td>Automated Information Management</td>
</tr>
<tr>
<td>AMHS</td>
<td>Automated Message Handling System</td>
</tr>
<tr>
<td>ANSI</td>
<td>American National Standards Institute</td>
</tr>
<tr>
<td>API</td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td>ASAS</td>
<td>All-Source Analysis System</td>
</tr>
<tr>
<td>ASCII</td>
<td>American Standard Code II</td>
</tr>
<tr>
<td>ATM</td>
<td>Asynchronous Transfer Mode</td>
</tr>
<tr>
<td>AT&amp;T</td>
<td>American Telephone and Telegraph</td>
</tr>
<tr>
<td>AUTODIN</td>
<td>Automatic Digital Network</td>
</tr>
<tr>
<td>BERT</td>
<td>Bit Error Rate Test</td>
</tr>
<tr>
<td>BIND</td>
<td>Berkeley Internet Name Domain</td>
</tr>
<tr>
<td>BSN</td>
<td>Berkeley Software Distribution</td>
</tr>
<tr>
<td>C2</td>
<td>Command and Control</td>
</tr>
<tr>
<td>C4I</td>
<td>Command, Control, Communications, Computers and Intelligence</td>
</tr>
<tr>
<td>CAD</td>
<td>Computer Aided Design</td>
</tr>
<tr>
<td>CAE</td>
<td>Computer Aided Engineering</td>
</tr>
<tr>
<td>CAM</td>
<td>Computer Aided Manufacturing</td>
</tr>
<tr>
<td>CATIS</td>
<td>Computer Aided Tactical Information System</td>
</tr>
<tr>
<td>CD</td>
<td>Compact Disk</td>
</tr>
<tr>
<td>CDROM</td>
<td>Compact Disc Read-Only Memory</td>
</tr>
<tr>
<td>CEP</td>
<td>Circular Error Probability</td>
</tr>
<tr>
<td>CI</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>CINC</td>
<td>Commander-in-Chief</td>
</tr>
<tr>
<td>CINCLANTFLT</td>
<td>Commander-in-Chief, Atlantic Fleet</td>
</tr>
<tr>
<td>CIO</td>
<td>Central Imagery Office</td>
</tr>
<tr>
<td>CJCS</td>
<td>Chairman, Joint Chiefs of Staff</td>
</tr>
<tr>
<td>CJTF</td>
<td>Commander, Joint Task Force</td>
</tr>
<tr>
<td>CO</td>
<td>Commanding Officer</td>
</tr>
<tr>
<td>COE</td>
<td>Common Operating Environment</td>
</tr>
<tr>
<td>COCOM</td>
<td>Combatant Command</td>
</tr>
<tr>
<td>COMINT</td>
<td>Communications Intelligence</td>
</tr>
<tr>
<td>COMSAT</td>
<td>Communications Satellite</td>
</tr>
<tr>
<td>CONOPS</td>
<td>Concept of Operations</td>
</tr>
<tr>
<td>CONUS</td>
<td>Continental United States</td>
</tr>
<tr>
<td>COTS</td>
<td>Commercial Off-the-Shelf</td>
</tr>
<tr>
<td>CPU</td>
<td>Computer Processing Unit or Central Processing Unit</td>
</tr>
<tr>
<td>CS</td>
<td>Constant Source</td>
</tr>
<tr>
<td>CSE</td>
<td>Client Server Environment</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>CUA</td>
<td>Common User Access</td>
</tr>
<tr>
<td>CUBIC</td>
<td>Common User Baseline for the Intelligence Community</td>
</tr>
<tr>
<td>5D</td>
<td>Demand Driven Direct Digital Dissemination</td>
</tr>
<tr>
<td>DB</td>
<td>Data Base</td>
</tr>
<tr>
<td>DCI</td>
<td>Director of Central Intelligence</td>
</tr>
<tr>
<td>DDN</td>
<td>Defense Data Network</td>
</tr>
<tr>
<td>DDS</td>
<td>Digital Data Service</td>
</tr>
<tr>
<td>DEC</td>
<td>Digital Equipment Corporation</td>
</tr>
<tr>
<td>DIA</td>
<td>Defense Intelligence Agency</td>
</tr>
<tr>
<td>DII</td>
<td>Defense Information Infrastructure</td>
</tr>
<tr>
<td>DIN</td>
<td>Defense Information Network</td>
</tr>
<tr>
<td>DISA</td>
<td>Defense Information Systems Agency</td>
</tr>
<tr>
<td>DISN</td>
<td>Defense Information Systems Network</td>
</tr>
<tr>
<td>DISNET</td>
<td>Defense Integrated Secure Network</td>
</tr>
<tr>
<td>DISUM</td>
<td>Daily Intelligence Summary</td>
</tr>
<tr>
<td>DITDS</td>
<td>Defense Intelligence Threat Database System</td>
</tr>
<tr>
<td>DMA</td>
<td>Defense Mapping Agency (new name NIMA)</td>
</tr>
<tr>
<td>DNI</td>
<td>Director of Naval Intelligence</td>
</tr>
<tr>
<td>DNS</td>
<td>Domain Name Server</td>
</tr>
<tr>
<td>DINSIX</td>
<td>DoDIIS Network Security for Information Exchange</td>
</tr>
<tr>
<td>DoD</td>
<td>Department of Defense</td>
</tr>
<tr>
<td>DoD-STD</td>
<td>Department of Defense Standard</td>
</tr>
<tr>
<td>DoDIIS</td>
<td>Department of Defense Intelligence Information System</td>
</tr>
<tr>
<td>DOS</td>
<td>Disk Operating System</td>
</tr>
<tr>
<td>DPI</td>
<td>Dots Per Inch</td>
</tr>
<tr>
<td>DSD</td>
<td>DoDIIS Standards Document</td>
</tr>
<tr>
<td>DSN</td>
<td>Defense Switched Network</td>
</tr>
<tr>
<td>DSNET</td>
<td>Defense Secure Network</td>
</tr>
<tr>
<td>Email</td>
<td>Electronic Mail</td>
</tr>
<tr>
<td>EDP</td>
<td>Electronic Data Processing</td>
</tr>
<tr>
<td>EEI</td>
<td>Essential Elements of Information</td>
</tr>
<tr>
<td>ELT</td>
<td>Electronic Light Table</td>
</tr>
<tr>
<td>EOB</td>
<td>Electronic Order of Battle</td>
</tr>
<tr>
<td>EPS</td>
<td>Encapsulated Postscript</td>
</tr>
<tr>
<td>ERB</td>
<td>Electronic Review Board</td>
</tr>
<tr>
<td>FDDI</td>
<td>Fiber Distributed Data Interface</td>
</tr>
<tr>
<td>FIPS</td>
<td>Federal Information Processing Standard</td>
</tr>
<tr>
<td>FITCPAC</td>
<td>Fleet Intelligence Training Center Pacific</td>
</tr>
<tr>
<td>FM</td>
<td>Frequency Modulation</td>
</tr>
<tr>
<td>FTP</td>
<td>File Transfer Protocol</td>
</tr>
<tr>
<td>FY</td>
<td>Fiscal Year</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>GCCS</td>
<td>Global Command and Control System</td>
</tr>
<tr>
<td>GDIP</td>
<td>General Defense Intelligence Program</td>
</tr>
<tr>
<td>GENSER</td>
<td>General Services</td>
</tr>
<tr>
<td>GFE</td>
<td>Government Furnished Equipment</td>
</tr>
<tr>
<td>GFI</td>
<td>Government Furnished Information</td>
</tr>
<tr>
<td>GFS</td>
<td>Government Furnished Software</td>
</tr>
<tr>
<td>GIF</td>
<td>Grabbed Image Format</td>
</tr>
<tr>
<td>GIS</td>
<td>Geographic Information System</td>
</tr>
<tr>
<td>GMT</td>
<td>Greenwich Mean Time (Military ZULU Time)</td>
</tr>
<tr>
<td>GOTs</td>
<td>Government Off-the-Shelf</td>
</tr>
<tr>
<td>GPIB</td>
<td>General Purpose Interface Bus (formally HPIB)</td>
</tr>
<tr>
<td>GPS</td>
<td>Global Positioning System</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>HCI</td>
<td>Human Computer Interface</td>
</tr>
<tr>
<td>HF</td>
<td>High Frequency</td>
</tr>
<tr>
<td>Hippi</td>
<td>High Performance Peripheral Imaging</td>
</tr>
<tr>
<td>HiPPIE</td>
<td>High Performance Peripheral and Imaging Enabler</td>
</tr>
<tr>
<td>HPIBM</td>
<td>Hewlett Packard Interface Bus</td>
</tr>
<tr>
<td>HQ</td>
<td>Headquarters</td>
</tr>
<tr>
<td>HUMINT</td>
<td>Human Intelligence</td>
</tr>
<tr>
<td>IAS</td>
<td>Interactive Application System</td>
</tr>
<tr>
<td>IBM</td>
<td>International Business Machines</td>
</tr>
<tr>
<td>ICD</td>
<td>Interface Control Document</td>
</tr>
<tr>
<td>IDBTF</td>
<td>Integrated Database Transaction Format</td>
</tr>
<tr>
<td>IDHS</td>
<td>Intelligence Data Handling System</td>
</tr>
<tr>
<td>IEEE</td>
<td>Institute of Electrical and Electronic Engineers</td>
</tr>
<tr>
<td>IMINT</td>
<td>Imagery Intelligence</td>
</tr>
<tr>
<td>INMARSAT</td>
<td>International Maritime Satellite</td>
</tr>
<tr>
<td>INTREP</td>
<td>Intelligence Report</td>
</tr>
<tr>
<td>INTSUM</td>
<td>Intelligence Summary</td>
</tr>
<tr>
<td>IOC</td>
<td>Initial Operational Capability</td>
</tr>
<tr>
<td>I/O</td>
<td>Input/Output</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol</td>
</tr>
<tr>
<td>IPU</td>
<td>Intelligent Processing Unit</td>
</tr>
<tr>
<td>ISO</td>
<td>International Organization for Standardization</td>
</tr>
<tr>
<td>ISSO</td>
<td>Information Systems Security Officer</td>
</tr>
<tr>
<td>JAMPS</td>
<td>Joint Automated Message Preparation System</td>
</tr>
<tr>
<td>JBOC</td>
<td>JDISS Basic Operator Course</td>
</tr>
<tr>
<td>JCS</td>
<td>Joint Chiefs of Staff</td>
</tr>
<tr>
<td>JDISS</td>
<td>Joint Deployable Intelligence Support System</td>
</tr>
<tr>
<td>JES</td>
<td>JDISS Embedded Support</td>
</tr>
<tr>
<td>JIC</td>
<td>Joint Intelligence Center</td>
</tr>
<tr>
<td>Acronym</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>JICPAC</td>
<td>Joint Intelligence Center, Pacific</td>
</tr>
<tr>
<td>JIMS</td>
<td>Joint Intelligence Message System</td>
</tr>
<tr>
<td>JTAP</td>
<td>Joint Intelligence Training Activity, Pacific</td>
</tr>
<tr>
<td>JMCIS</td>
<td>Joint Maritime Command Information System</td>
</tr>
<tr>
<td>JOTS</td>
<td>Joint Operational Tactical System</td>
</tr>
<tr>
<td>JROC</td>
<td>Joint Reserve Operators Course</td>
</tr>
<tr>
<td>JSTARS</td>
<td>Joint Surveillance Target Attack Radar System</td>
</tr>
<tr>
<td>JTF</td>
<td>Joint Task Force</td>
</tr>
<tr>
<td>JTTCC</td>
<td>JDISS Tactical Troubleshooting Course</td>
</tr>
<tr>
<td>JUIC</td>
<td>Joint Universal Imagery Client</td>
</tr>
<tr>
<td>JVOX</td>
<td>Interactive Packet Voice Terminal - Secure Voice</td>
</tr>
<tr>
<td>JWICS</td>
<td>Joint Worldwide Intelligence Communications System</td>
</tr>
<tr>
<td>JWID</td>
<td>Joint Warrior Interoperability Demonstration</td>
</tr>
<tr>
<td>KFLOPS</td>
<td>Thousand Floating Point Operations Per Second</td>
</tr>
<tr>
<td>KHz</td>
<td>Kiloherzt</td>
</tr>
<tr>
<td>KISS</td>
<td>Korean Intelligence Support System</td>
</tr>
<tr>
<td>LAMPS</td>
<td>LANTCOM (ACOM) Automated Message Processing System</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>LANTIRN</td>
<td>Low Altitude Navigation and Targeting Infrared System for Night</td>
</tr>
<tr>
<td>LOC</td>
<td>Lines of Communication</td>
</tr>
<tr>
<td>LOCE</td>
<td>Linked Operations Center, Europe</td>
</tr>
<tr>
<td>LOS</td>
<td>Line of Sight</td>
</tr>
<tr>
<td>MASINT</td>
<td>Measurement and Signature Intelligence</td>
</tr>
<tr>
<td>MAXI</td>
<td>Modular Architecture for Exchange of Intelligence</td>
</tr>
<tr>
<td>MC&amp;G</td>
<td>Mapping, Charting and Geodesy</td>
</tr>
<tr>
<td>MCM</td>
<td>Multimedia Collaboration Manager</td>
</tr>
<tr>
<td>MHz</td>
<td>Megahertz</td>
</tr>
<tr>
<td>MIDB</td>
<td>Modernized Integrated Database</td>
</tr>
<tr>
<td>MIIDS/IDB</td>
<td>Military Intelligence Integrated Database System/Integrated Database</td>
</tr>
<tr>
<td>MILNET</td>
<td>Military Network</td>
</tr>
<tr>
<td>MIL-STD</td>
<td>Military Standard</td>
</tr>
<tr>
<td>MIPS</td>
<td>Million Instruction Per Second</td>
</tr>
<tr>
<td>MISREP</td>
<td>Mission Report</td>
</tr>
<tr>
<td>MIT</td>
<td>Massachusetts Institute of Technology</td>
</tr>
<tr>
<td>MLS</td>
<td>Multi-Level Security</td>
</tr>
<tr>
<td>MNW</td>
<td>Multiple Network Workstation</td>
</tr>
<tr>
<td>MSS</td>
<td>Mission Support System</td>
</tr>
<tr>
<td>MWE</td>
<td>Mount Whitney Experiment</td>
</tr>
<tr>
<td>NATO</td>
<td>North Atlantic Treaty Organization</td>
</tr>
<tr>
<td>NCA</td>
<td>National Command Authority</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Full Form</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------</td>
</tr>
<tr>
<td>NFS</td>
<td>Network File System</td>
</tr>
<tr>
<td>NIMA</td>
<td>National Imagery Mapping Agency</td>
</tr>
<tr>
<td>NIPS</td>
<td>Naval Intelligence Processing System</td>
</tr>
<tr>
<td>NIS</td>
<td>Network Information Server</td>
</tr>
<tr>
<td>NISE</td>
<td>Naval Integrated System for Exploitation</td>
</tr>
<tr>
<td>NIST</td>
<td>National Intelligence Support Team</td>
</tr>
<tr>
<td>NITF</td>
<td>National Imagery Transmission Format</td>
</tr>
<tr>
<td>NMJIC</td>
<td>National Military Joint Intelligence Center</td>
</tr>
<tr>
<td>NRT</td>
<td>Near-Real Time</td>
</tr>
<tr>
<td>NSA</td>
<td>National Security Agency</td>
</tr>
<tr>
<td>NT</td>
<td>Network Terminal</td>
</tr>
<tr>
<td>NTCS</td>
<td>Naval Tactical Command System</td>
</tr>
<tr>
<td>NTP</td>
<td>Network Time Protocol</td>
</tr>
<tr>
<td>NVDET</td>
<td>Network Virtual Data Entry Terminal</td>
</tr>
<tr>
<td>ONI</td>
<td>Office of Naval Intelligence</td>
</tr>
<tr>
<td>O/S</td>
<td>Operating System</td>
</tr>
<tr>
<td>OSD</td>
<td>Office of Secretary of Defense</td>
</tr>
<tr>
<td>OSF</td>
<td>Open Software Foundation</td>
</tr>
<tr>
<td>PACCMS</td>
<td>Pacific Crisis Management System</td>
</tr>
<tr>
<td>PACOM</td>
<td>Pacific Command</td>
</tr>
<tr>
<td>PAL</td>
<td>Process Asset Library</td>
</tr>
<tr>
<td>PASS</td>
<td>PACOM ADP Server Site</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>PDN</td>
<td>Public Data Network</td>
</tr>
<tr>
<td>PIDF</td>
<td>Paragon Imaging Data Format</td>
</tr>
<tr>
<td>PMGB</td>
<td>Program Managers Guidance Memorandum</td>
</tr>
<tr>
<td>PMO</td>
<td>Program Management Office</td>
</tr>
<tr>
<td>POSIX</td>
<td>Portable Operating System Interface for Computer Environments</td>
</tr>
<tr>
<td>PPM</td>
<td>Pages Per Minute</td>
</tr>
<tr>
<td>PROM</td>
<td>Programmable Read-Only Memory</td>
</tr>
<tr>
<td>PSN</td>
<td>Packet Switching Node</td>
</tr>
<tr>
<td>PTT</td>
<td>Push-To-Talk</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>RDIST</td>
<td>Remote Distribution</td>
</tr>
<tr>
<td>RF</td>
<td>Radio Frequency</td>
</tr>
<tr>
<td>RFI</td>
<td>Request for Information</td>
</tr>
<tr>
<td>RGB</td>
<td>Red, Green, Blue</td>
</tr>
<tr>
<td>RISC</td>
<td>Reduced Instruction Set Computer</td>
</tr>
<tr>
<td>ROE</td>
<td>Rules of Engagement</td>
</tr>
<tr>
<td>ROI</td>
<td>Region of Interest</td>
</tr>
<tr>
<td>ROM</td>
<td>Read-Only Memory</td>
</tr>
<tr>
<td>RTIC</td>
<td>Real-Time Intelligence to the Cockpit</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>SA</td>
<td>Security Analysis</td>
</tr>
<tr>
<td>SAFE</td>
<td>Semi-Automated File Environment</td>
</tr>
<tr>
<td>SATCOM</td>
<td>Satellite Communications</td>
</tr>
<tr>
<td>SCl</td>
<td>Sensitive Compartmented Information</td>
</tr>
<tr>
<td>SCIF</td>
<td>Sensitive Compartmented Information Facility</td>
</tr>
<tr>
<td>SCMP</td>
<td>Software Configuration Management Plan</td>
</tr>
<tr>
<td>SCSI</td>
<td>Small Computer System Interface</td>
</tr>
<tr>
<td>SFUG</td>
<td>Security Features User’s Guide</td>
</tr>
<tr>
<td>SHF</td>
<td>Super High Frequency</td>
</tr>
<tr>
<td>SI</td>
<td>Special Intelligence</td>
</tr>
<tr>
<td>SIDS</td>
<td>Secondary Imagery Dissemination Systems</td>
</tr>
<tr>
<td>SIGINT</td>
<td>Signals Intelligence</td>
</tr>
<tr>
<td>SIO</td>
<td>Senior Intelligence Officer</td>
</tr>
<tr>
<td>SIPRNET</td>
<td>Secret Internet Protocol Network</td>
</tr>
<tr>
<td>SLIP</td>
<td>Serial Line Internet Protocol</td>
</tr>
<tr>
<td>SOP</td>
<td>Standard Operating Procedures</td>
</tr>
<tr>
<td>SPINS</td>
<td>Special Instructions</td>
</tr>
<tr>
<td>SSC</td>
<td>Standard Systems Center</td>
</tr>
<tr>
<td>SSO</td>
<td>Special Security Office</td>
</tr>
<tr>
<td>STS-I</td>
<td>Special Technology Support for Intelligence</td>
</tr>
<tr>
<td>STU</td>
<td>Secure Telephone Unit</td>
</tr>
<tr>
<td>SUM</td>
<td>Software User’s Manual</td>
</tr>
<tr>
<td>SYS</td>
<td>System</td>
</tr>
<tr>
<td>TACELINT</td>
<td>Tactical Electronic Intelligence</td>
</tr>
<tr>
<td>TACO</td>
<td>Tactical Communications</td>
</tr>
<tr>
<td>TADIL</td>
<td>Tactical Digital Information Link</td>
</tr>
<tr>
<td>TAFIM</td>
<td>Technical Architecture Framework for Information Management</td>
</tr>
<tr>
<td>TAR</td>
<td>Tape Archive (also Tar)</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol/Internet Protocol</td>
</tr>
<tr>
<td>TDA</td>
<td>Tactical Decision Aid</td>
</tr>
<tr>
<td>TELNET</td>
<td>Telecommunications Network</td>
</tr>
<tr>
<td>TFUG</td>
<td>Trusted Facility User’s Guide</td>
</tr>
<tr>
<td>TIBS</td>
<td>Tactical Information Broadcast Service</td>
</tr>
<tr>
<td>TIDAS</td>
<td>Trusted Intelligence-link Dissemination Access Server</td>
</tr>
<tr>
<td>TIFF</td>
<td>Tagged Image File Format</td>
</tr>
<tr>
<td>TRAP</td>
<td>TRE Related Application Program</td>
</tr>
<tr>
<td>TRE</td>
<td>Tactical Receive Equipment</td>
</tr>
<tr>
<td>TTY</td>
<td>Teletype Terminal</td>
</tr>
<tr>
<td>UDP</td>
<td>User Datagram Protocol</td>
</tr>
<tr>
<td>UHF</td>
<td>Ultra High Frequency</td>
</tr>
<tr>
<td>UIDL</td>
<td>User Interface Definition Language</td>
</tr>
<tr>
<td>UIMS</td>
<td>User Interface Management System</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>UPS</td>
<td>Un-interruptible Power Supply</td>
</tr>
<tr>
<td>USACOM</td>
<td>United States Atlantic Command</td>
</tr>
<tr>
<td>USCINCLANT</td>
<td>United States Commander-in-Chief Atlantic (USACOM)</td>
</tr>
<tr>
<td>USCINCPAC</td>
<td>United States Commander-in-Chief Pacific (USPACOM)</td>
</tr>
<tr>
<td>USMTF</td>
<td>United States Message Text Format</td>
</tr>
<tr>
<td>USPACOM</td>
<td>United States Pacific Command</td>
</tr>
<tr>
<td>VHF</td>
<td>Very High Frequency</td>
</tr>
<tr>
<td>VMS</td>
<td>Virtual Memory System</td>
</tr>
<tr>
<td>VPN</td>
<td>Voice Product Net</td>
</tr>
<tr>
<td>WWMCCS</td>
<td>Worldwide Military Command and Control System</td>
</tr>
<tr>
<td>WX</td>
<td>Weather</td>
</tr>
<tr>
<td>WYSIWYG</td>
<td>What You See Is What You Get</td>
</tr>
<tr>
<td>X11R5</td>
<td>X Window System Version 11, Release 5 (example)</td>
</tr>
<tr>
<td>X.Desktop</td>
<td>X Windows - Desktop</td>
</tr>
<tr>
<td>XDM</td>
<td>X Display Manager</td>
</tr>
<tr>
<td>XIDB</td>
<td>Extended Integrated Data Base</td>
</tr>
<tr>
<td>XFTP</td>
<td>X Windows - File Transfer Protocol</td>
</tr>
<tr>
<td>XMIT</td>
<td>Transmit</td>
</tr>
<tr>
<td>X Windows</td>
<td>UNIX's GUI</td>
</tr>
</tbody>
</table>
EXECUTIVE SUMMARY

The purpose of this thesis is to create a new user's guide for the Joint Deployable Intelligence Support System's (JDISS) Communication and Images applications. This thesis is needed to assist new JDISS users by providing a central source of instructions for the two JDISS core applications which require the most help support for basic operations. This is accomplished by examining the core applications, Communications and Images, and identifying functions and processes that are difficult to understand, as well as functions and processes that lack sufficient instructions for new users. Using the results of this examination, descriptive, step-by-step simple instructions enhanced by illustrations and images have been created that target the new user. This effort was initiated after experiencing difficulties in learning and operating JDISS using the Computer System Reference Manual for JDISS, version 2.0 (CSRM, 1995). The JDISS Desktop and Utilities applications were included in the thesis since the first is a pre-requisite to the core applications and the second supplements the core applications.

The JDISS Communications and Images Application Guide for New Users (Guide) approaches the problems of the new user in two ways. First, it provides an overview of the JDISS Desktop and utilities applications. In the JDISS Desktop section, the Guide discusses the standard graphical user interface (GUI) used on UNIX — X Windows. The new user is carefully guided through the basic functions and requirements of performing operations within X Windows with the specific purpose in mind of ensuring the user is comfortable with the desktop GUI, X Windows control functions, and the various sub-menus and pop-up menus that the user will experience. In the
Utilities Applications section, convenient utility tools are provided which enable the user to expedite both local use to include file(s) manipulation and remote dissemination/retrieval of an assortment of products. Second, the Guide provides detailed “new user” type instructions for the communications and images applications. The instructions, although not all-inclusive, are simply written with many supporting images depicting the program responses to the user’s inputs. Processes that require special knowledge, software, hardware, etc. or are beyond basic user needs, i.e., require advanced user knowledge, are not included and are not required for users to appreciate basic JDISS applications.

JDISS has not just grown or evolved since its emergence, it has prospered and continues to have a bright future. A historic perspective and progression of the JDISS program starting with its inception at the United States Atlantic Command (USACOM) through today’s JDISS applications and JDISS planned improvements as well as future applications to be demonstrated at the Joint Warrior Interoperability Demonstration 1997 (JWID97) are provided.

The JDISS program was developed to ensure that each of the U.S. services and agencies had a compatible intelligence system and one that would provide a common data standard permitting interoperability, both intra-service as well as inter-service use. JDISS is best described as an integrated set of commercial-off-the-shelf (COTS) software applications including capabilities for word processing, e-mail, graphics, communication applications and imagery manipulation. The JDISS program is characterized as a DoD Intelligence Information System (DoDIIS) workstation providing tactical extension of the DoDIIS network. DoDIIS is a federation of individual sites interconnected by a
worldwide network at the sensitive compartmented information (SCI) security level (Myers, 1994). JDISS was built in strict accordance with the DoDIIS profile with lifecycle management responsibility under the purview of the DoDIIS Executive Agent, the Office of Naval Intelligence (ONI).

The JDISS Program Management Office (PMO) works closely with the Services, Joint Chiefs of Staff (J6), the Defense Information Systems Agency (DISA) Office for Standards, and other organizations on the evolution of standards so that JDISS meets the full extent of interoperability requirements for a Joint Task Force’s (JTF) warfighting environment. Ensuring interoperability between JDISS and interfacing systems is a major emphasis, as well as security accreditation, releasability and sanitization, and the integration of new functionality for future JDISS releases. (JBOC, 1996)

JDISS is considered the coordinated intelligence community-sponsored system for providing intelligence to the warfighter. As stated, the purpose of JDISS is to provide the foundation for achieving strategic to tactical intelligence interoperability across services. However, none of this is possible without trained JDISS users. The JDISS system design allows almost any user with basic typing and fundamental computer skills to access the system through a common GUI desktop and an integrated group of standard applications. These interactive applications and their functionality are the power of JDISS. The descriptive, step-by-step JDISS Guide was developed specifically to target new users with no JDISS background. The new user, assisted by many instructive illustrations and images will be able to quickly learn and perform the basic operations listed above. As JDISS global use continues to expand, it is anticipated that this guide for new users will benefit future JDISS users worldwide.
I. INTRODUCTION

The purpose of this thesis is to create a basic user’s guide for the Joint Deployable Intelligence Support System’s (JDISS) Communication and Images applications. This is accomplished by selecting the two core JDISS applications, Communications and Images, then examining the applications within the core applications to identify functions and processes that are difficult to understand, as well as functions and processes that lack sufficient instructions for the new user. Using the results of this examination, descriptive, step-by-step simple instructions enhanced by illustrations and images have been created that target the new user. This effort was initiated after experiencing difficulties in learning and operating JDISS using the Computer System Reference Manual for JDISS, version 2.0 (CSRM, 1995). The JDISS Desktop and Utilities applications were included in the thesis since the first is a pre-requisite to the core applications and the second supplements the core applications.

The core of this thesis is Appendix A, JDISS Communications and Imagery Application Guide for New Users (Guide). The Guide has four sections titled: JDISS Desktop; JDISS Communications Application; JDISS Images Application; and JDISS Utilities Applications. These sections provide the instructions necessary for a new user to learn and perform the basic operations associated with communicating between JDISS and non-JDISS terminals, performing real-time problem solving and analysis sessions with other JDISS users worldwide, transmitting and receiving data files, transmitting and receiving specific requests for intelligence data and imagery, and supporting digitized
imagery exchange and manipulation. Appendix A is a stand-alone user’s guide that may be removed from the thesis without affecting the content or the purpose of the guide.

The Guide approaches the problems of the new user in two ways: First, it provides an overview of the JDISS Desktop and Utilities Applications. In the JDISS Desktop section, the guide discusses the standard graphical user interface (GUI) used on UNIX — X Windows. The new user is carefully guided through the basic functions and requirements of performing operations within X Windows with the specific purpose in mind of ensuring the user is comfortable with the desktop GUI, X Windows control functions, and the various sub-menus and pop-up menus that the user will experience. The JDISS Desktop application is a pre-requisite for learning to use the JDISS core applications Communications and Images. In the Utilities Applications section, convenient utility tools are provided which enable the user to expedite both local use to include file(s) manipulation and remote dissemination/retrieval of an assortment of products. Second, it provides detailed “new user” type instructions to supplement the Communications and Images Applications. The instructions, although not all-inclusive, are simply written with many supporting images depicting the program responses to the user’s inputs. Processes that require special knowledge, software, hardware, etc., or are beyond basic user needs, i.e., require advanced user knowledge, are not included and are not required for users to appreciate basic JDISS applications.

In addition, the thesis provides a chapter on the prosperity of JDISS. This chapter provides a historic perspective and progression of the JDISS program, starting with its inception at the United States Atlantic Command (USACOM) through today’s JDISS applications and JDISS planned improvements and future applications to be demonstrated
at the Joint Warrior Interoperability Demonstration 1997 (JWID97). As this chapter reveals, the JDISS program provides a family of software and hardware capabilities allowing connectivity and interoperability with the intelligence systems that support non-deployed and deployed forces in times of peace, crisis and war. JDISS provides the Joint Intelligence Centers (JICs), Joint Task Forces (JTFs), and other operational commanders with on-site automation support and the connectivity to make best use of the Intelligence Community’s resources (JBOC, 1996).

It is anticipated that this guide will benefit future JDISS users worldwide.
II. JDISS PROSPERITY

JDISS is best described as an integrated set of commercial-off-the-shelf (COTS) software applications. These common applications, combined with specific communications interfaces, guarantee interoperability between JDISS users from all services across strategic, theater and tactical warfare areas. A key to JDISS prosperity is its characterization as a Department of Defense Intelligence Information System (DoDIIS) providing a tactical extension of the DoDIIS network to the battlefield. DoDIIS is a federation of individual sites interconnected by a worldwide network at the sensitive compartmented information (SCI) security level. It is also a term that applies to all information systems that process foreign intelligence without regard to classification level, source or sponsoring agency. In short, DoDIIS is a synergism of Intelligence Data Handling Systems (IDHS) with a state-of-the-art infrastructure (Myers, 1994).

The JDISS Program Management Office (PMO) works closely with the Services, Joint Chiefs of Staff (J6), the Defense Information Systems Agency (DISA) Office for Standards, and other organizations on the evolution of standards so that they meet the full extent of interoperability requirements for a Joint Task Force’s (JTF) warfighting environment. Additionally, ensuring interoperability between JDISS and interfacing systems is a major emphasis, as well as security accreditation, releasability and sanitization, and the integration of new functionality for future JDISS releases. The PMO is committed to successfully meeting the real needs of the user community (Alves, 1996).

This chapter is designed to provide the reader familiarity with JDISS and is written to promote interest in the JDISS program. JDISS has not just grown or evolved
since its emergence, it has prospered and today has a bright outlook to the future. The chapter is divided into three major sections: JDISS Yesterday, JDISS Today and JDISS Tomorrow. JDISS Yesterday provides a brief but descriptive accounting of the development of JDISS. JDISS Today is the largest section and provides a summary of JDISS applications and information on why JDISS is a powerful intelligence communication and dissemination tool. The last section, JDISS Tomorrow, provides a review of the new capabilities that will be demonstrated at the Joint Warrior Interoperability Demonstration 1997 (JWID97).

A. JDISS YESTERDAY

In the early 1990s, the information systems staff of the United States Atlantic Command (USACOM) was challenged to field a COTS standards-based set of technologies to enable a JTF staff and down-echelon staffs to directly access theater and national DoDIIS assets. The prototype was first tested on the Commander-in-Chief, Atlantic Fleet (CINCLANTFLT) flag ship, the USS Mount Whitney. The “Mount Whitney Experiment” (MWE) consisted of a SUN workstation with the UNIX operating system connected via a shipborne network router and AT&T STU-III (secure telephone unit) to another STU-III and network router at USACOM. International Maritime Satellite (INMARSAT) commercial full duplex satellite communications were employed to extend DoDIIS services from ship to shore. The MWE used COTS and Defense Data Network (DDN) Internet standard protocol, i.e., Transmission Control Protocol/Internet Protocol (TCP/IP), to enable remote terminal connections. This allowed hardware independent operations. The MWE workstation was connected to DoDIIS International Business Machines (IBM) mainframes, such as the Semi-Automated File Environment
(SAFE) and LANTCOM's (now ACOM) Automated Message Processing System (LAMPS), and to Digital Equipment Corporation (DEC) based DoDIIS technology. The key was the use of COTS standards enforced within DoDIIS and DDN. The MWE Sun also had a COTS word processor (Word Perfect), electronic mail (Z-Mail), and an image manipulation/viewing package (Electronic Light Table Two (ELT-2)). The effort proved successful and became the predecessor program of JDISS version 1.0. It was initially deployed as LANTCOM's Deployable Intelligence System (LANTDIS). LANTDIS was the work of many DoDIIS information systems professionals within DoD, the MITRE Corporation and other supporting contractors. It was billed, "the most influential intelligence information technology program in history." (Myers, 1994)

B. **JDISS TODAY**

JDISS is considered the coordinated community-sponsored system to provide intelligence to the warfighter. This statement reflects JDISS objectives of jointness and interoperability and the desire to provide intelligence information to the operational commanders who need it when they need it. It is the purpose of JDISS to provide the foundation for achieving all service, joint strategic to tactical intelligence interoperability.

The JDISS program establishes a standard core product for the DoDIIS to provide operational commanders with communications interface devices, virtual host emulation, office automation, map graphics, basic imagery manipulation, and access to host applications and data. As a tactical extension of the DoDIIS network, JDISS uses the Joint World-Wide Intelligence Communications System (JWICS) for connectivity. JWICS is a family of networks designed to provide high speed, interactive, multimedia, IP-based secure telecommunications using dedicated intelligence communications lines.
Installation and integration of JDISS at each end of a JWICS link permits the extensions of the DoDIIS network capabilities to support deployed forces.

JDISS is deployable using a laptop or desktop UNIX workstation and can operate wherever there is space for a computer and access to JWICS. It is scalable from a standalone workstation through a full client-server environment (CSE) implementation. JDISS provides:

- Timely, secure and direct access to theater and national intelligence resources.
- Transmission in real or near-real time via secure low bandwidth links.
- Simultaneous duplex transmissions by numerous users.
- Basic imagery analysis and dissemination capabilities.
- Interoperability and easy input among different graphics formats.
- Integration of JDISS as an application on tactical workstations.
- Specific office automation and support functions.

The result is an integrated group of applications, hardware platforms, packaging options and communications interfaces configured for specific intelligence needs. The equipment and software form a non-deployed and field-deployable intelligence support system that provides timely intelligence support to operational forces worldwide.

1. JDISS Applications

This section discusses the following five major JDISS applications: Communications, Electronic Mail, Office Tools, Images, and Utilities. JDISS is unique in that it provides the same look and feel to wide variety of users worldwide through the use of a common desktop, yet allows users the option to tailor a personal JDISS directory with command-specific applications. This gives JDISS users the best of both worlds.
joint interoperability through the use of COTS standards and configuration management of core applications yet access to command-unique applications from one workstation. These applications together form an integrated group.

a. Communications

The purpose of the Communications application is to provide several means of communicating or checking connectivity with other JDISS workstations. Communications is discussed in detail in Appendix A, the JDISS Guide. The communications pathway is normally JWICS, as discussed earlier in this chapter, but may be SIPRNET or any other communications link providing IP-based connectivity with another JDISS workstation. SIPRNET connectivity is an example of JDISS use at the SCI tactical level and the pathway for JDISS' integration into the Global Command and Control System (GCCS). Communications provides the following menu-selectable options.

1) Alert - Provides the ability to send short, high priority messages that demand immediate attention to another JDISS workstation. The distant JDISS workstation receives an "ALERT pop-up window" that requires the user to accept the message before continuing local workstation operation.

2) Chatter - Allows informal text communications between multiple JDISS workstations worldwide to assist in real-time problem solving, analysis, and dissemination issues. Communications will be at the same security level as the JDISS pathway being used and provides a full duplex, interactive communications capability via the keyboard.
(3) JPings - Provides the ability to check the communications pathway connectivity between the user’s terminal and other JDISS terminals. Specifically, JPings can tell whether the user’s terminal can “see” the intended recipient which means that JPings can also be used as a communications troubleshooting tool.

(4) Collage - Provides an interactive whiteboard for sending screen grabs, images, graphics and text; as well as providing a corresponding chatter capability. If the Collage session is between only two terminals, drawings appear at the distant terminal as they are being drawn.

(5) SLIP (Serial Line Internet Protocol) - SLIP is an alternative means of communicating with a distant JDISS terminal in the event the network is down. The most common alternative pathway when using SLIP is a dial-up modem over STU-III. SLIP requires that both users work together to establish serial port to serial port connectivity. SLIP only works with JPings and Chatter.

(6) JVOX (Interactive Packet Voice Terminal - Secure Voice) - Provides an interactive method between JDISS terminals to exchange secure voice messages. JVOX must be activated on the distant terminal and may be configured for either full or half duplex operations. JVOX may be used at the same time as other JDISS applications enabling real-time problem solving.

(7) XFTP (X Windows File Transfer Protocol) - Provides the capability to transfer or search for files and perform various directory manipulation commands, both remotely and locally. XFTP is a X Windows graphical user interface (GUI) to UNIX’s file transfer protocol (FTP).
(8) Send File - Allows the user to send and receive files from another JDISS workstation using a point and click window tool. Using Send File, the distant user must accept the file before it is transferred. This control of file transfers ensures that files too large for the receiving station can be rejected and that the receiving station knows that the file is now available locally.

(9) XMIT (Transmit) - Allows users with different levels of computer expertise and system authority to use and configure the tactical communications (TACO) protocol. By using a sign-on mechanism, XMIT only shows the user the functionality permitted by his privilege level which is previously assigned as either a normal or privileged user.

b. **Email (Electronic Mail)**

Applix Email provides another informal mechanism to communicate with other JDISS sites, as well as other non-JDISS sites using IP configured networks. Email is fully integrated with other Applix Office Tools (covered in later sections). It allows the user to attach documents, images and spreadsheets for dissemination to one or multiple destinations. A powerful Email function allows use of both personal and shared Email messages which differ only in degree of Email accessibility: an individual or a defined group of individuals. Email is a simple point-and-click application tool and works similarly to other Email programs and are not addressed in this thesis.

c. **Office Tools**

Applix Office Tools is an integrated office automation package that provides integrated access and use of Applix Word, Applix Spreadsheet and Applix Graphics (Interleaf, a document viewer using hyperlinked text, and Corel Draw are
optional programs). These basic office applications are identical to the Applix programs found on the GCCS main desk top window under Tools and are not addressed in this thesis.

d. Images

The purpose of the Images application is to provide the capability to accept and gather various imagery formats for display and manipulation for local use and/or dissemination to other JDISS sites. Images is discussed in detail in Appendix A, the Guide. The following is an overview of the three core and other optional applications within Images.

(1) ELT (Electronic Light Table) - Provides users an image processor with the ability to view, manipulate, annotate, format and save or print an image or selected regions of an image. ELT can also support the TACO (tactical communications) protocol, scanners and video frame grabbers. ELT is discussed in more detail in Appendix A, the JDISS Guide.

(2) Imagine - Is an optional JDISS package that analyses or creates graphical models for mapping applications often incorporating information from the Geographic Information System (GIS) database. Although JDISS user’s will see the Imagine icon on the JDISS main desktop, its special capabilities are not required by the common JDISS user and is beyond the scope of this thesis.

(3) JUIC (Joint Universal Imagery Client) - Is a Mosaic document viewer that provides access to multiple imagery sources. When selecting JUIC, the JDISS Home Page will be displayed which lists several other Home Pages that access various imagery servers. JUIC uses HTML browser technologies in common use.
worldwide. Further amplification is not provided or required for the purpose of this thesis.

(4) Digital Camera - Is an optional JDISS package that inputs still photographic images into JDISS from the Kodak DCS 200 or 420 Digital Camera. This intelligence tool analyzes and creates graphical models for mapping applications and is beyond the scope of this thesis.

(5) Hippi - Is a High Performance Peripheral and Imaging Enabler (HiPPIE) which provides an interface to ScanShop enabling images to be scanned into the system at various resolutions, manipulated and then saved and/or printed. Hippi also provides a SCSI (Small Computer System Interface) and GPIB (General Purpose Interface Bus) printer interface. Hippi is discussed in more detail in Appendix A, the JDISS Guide.

e. Utilities

Utilities are miscellaneous functions that allow users to print or save screens; import and export DOS files; display a time zone clock; access a calculator and calendar; set or change passwords; backup and restore files; etc. There are eighteen various utilities listed below that are available on all standard JDISS workstations. They are all covered in greater detail in Appendix A, JDISS Guide.

(1) Backup-Restore

(2) Calculator

(3) Calendar

(4) Clipboard

(5) Clock
(6) Dos Tools
(7) Shutdown
(8) Print Screen
(9) Project Manager
(10) System Load
(11) Save Screen
(12) CD-ROM
(13) Time Zone Clock
(14) Video Pix
(15) Soft Window
(16) Disk Stats
(17) Set Password
(18) Version (JDISS)

2. **JDISS Automatic Dissemination**

Although automatic dissemination is not a direct capability, the JDISS applications allow both automated “pull” and “push” of intelligence products between JDISS workstations. Both automated pull and push approaches are discussed briefly as well as the advantages of automatic dissemination a term which includes both automated Pull and Push dissemination.

a. **Pull Architecture**

Pull architecture is a systematic approach designed to take advantage of emerging data transfer technologies while easing the communications burden on traditional intelligence dissemination systems. Pull architecture allows intelligence
consumers to remotely access desired data at the time and place of their choosing as opposed to the intelligence producers “pushing” large amounts of information without regard to the needs of a specific user. A thorough knowledge of theater and national level intelligence products, producers and dissemination often is essential to maximize the benefits of Pull architecture. This information is available through the JICs or service intelligence centers and should be included as part of the deployment package. Pull can be automated (pre-specified searches or alerts) or manual (XFTP transfers, browsing home pages, etc.).

b. “Smart” Push

“Smart” Push complements Pull architecture. “Smart” Push is designed to more effectively use traditional intelligence dissemination methods for intelligence directed to individual warfighting activities. “Smart” Push is based on the understanding that not all intelligence consumers will have access to the Pull architecture and also that situations will arise that require broad-based intelligence dissemination (such as from a commander to his subordinates). Examples of “Smart” Push include the Tactical Receive Equipment (TRE) and the TRE Related Application Program (TRAP), which allow users to filter out undesired data, and the expanded use of CD-ROMS, which allow the replacement of standard hard copy publications. (JBOC, 1996) Additional examples of “Smart” Push for the warfighter could be manual (loaded to home pages) or automated (use of pre-selected methods to auto transmit intelligence to selected users by subject matter, location, etc.).
c. **Advantages**

There are three distinct advantages of automated dissemination: First, tactical units have access to critical information in the field whether they are in peacetime (an exercise), crisis or war. Second, users have access to other timely information based on their local situation. This could be in the form of a daily intelligence brief or near real-time analyst-to-analyst exchange of information and ideas. Third, users can choose what best suits their needs and limitations because JDISS is flexible. For example, JDISS allows for multimedia format. But if a multi-media format is not necessary or host communications cannot support it, JDISS can provide the same information in simpler formats, i.e., plain text instead of color with graphics and audio. (JBOC, 1996)

3. **JDISS Client-Server Environment (CSE)**

A CSE offers advantages in the sharing of information and resources. Although JDISS can run on stand-alone workstations, a CSE offers the best opportunities for maximizing the JDISS applications by allowing real-time sharing of information between JDISS sites both local and remote. It is not necessary for a user to have an in-depth knowledge of the CSE to use it but it will assist the user to better understand what resources are available and how they differ from a stand-alone workstation (JBOC, 1996). A CSE consist of workstations called clients and resource providers called servers. A client workstation also performs local information processing and can serve as a local workstation. Communication networks provide the connectivity for the CSE and are an integral and essential part of the overall functionality and performance of CSEs.
a. **Stand-alone Workstations**

Stand alone systems such as single workstations or personal computers are limited in their scope of operations or processing. They utilize their own processor to run programs or sort data and must have sufficient memory or disk storage to store the data for processing. While they may access other information on networks through a modem or communications link, they operate as an individual computing element. Typically everything a user needs is found on their workstations. The minimum requirements for a UNIX-based JDISS stand-alone workstation are listed in Appendix B, JDISS Workstation Requirements. (JBOC, 1996)

b. **Client-Server Workstations**

A CSE or architecture defines a relationship between users’ workstations (clients) and computer resources (servers), which may provide services to the client such as file storage and access (file server), printing services (print server), communications services (communications server) or facsimile services (fax server). The client must be an intelligent workstation, such as a SUN SPARC station, with its own processing and storage power to allow for more timely local processing and some data while sharing the load or processing requirements with the server(s). The CSE relationship consists of a request by the client and server processing and a response by a server, followed by more requests, processing and responses. If the client requests specific data, a server responds by processing the request and sending the data to the requesting client. (JBOC, 1996).

An important concept in CSEs is the ability of several servers to serve the same client (or many clients). CSEs operate in a shared processing and storage environment in which the clients and servers are sharing information via communications.
links and networks. As more clients and servers are added, the capabilities of the CSE expand and more services become available. Therefore, communications and networks become an essential and integral part of CSE computing, thereby facilitating the transfer of information between the clients and the servers. The minimum requirements for JDISS client and server workstations are listed in Appendix B, JDISS Workstations Requirements. (JBOC, 1996)

c. **JDISS Growth**

The Joint Staff has highlighted JDISS and JWICS in joint doctrine as the principal intelligence components for interoperability (JBOC, 1996). JDISS uses high bandwidth encrypted communications to move critical warfighting between the national level and the force level. JDISS can use virtually any available low to high bandwidth IP-based communications path. The key to JDISS today and for the future is its use of COTS standards. JDISS will continue to grow as the synergistic relationship between it and other intelligence and non-intelligence systems continue to improve. By building on standard applications and not systems, JDISS allows other programs to focus resources on the unique needs of the user.

C. **JDISS TOMORROW**

JDISS continues to improve and is now moving to JDISS version 3.0, a new deployable intelligence workstation based on the DII Windows NT (Network Terminal) configuration. By adopting the DII COE core as its infrastructure, JDISS version 3.0 is in the process of building an in-depth family of intelligence and collaborative add-on segments which can be reused in other DII-based systems. This is important, if not critical, to JDISS's continued growth as the JDISS global use continues to expand. As an
example, over 3,000 JDISS licenses have been purchased and installed worldwide (DII-JDISS, 1997).

The Joint Warrior Interoperability Demonstration 1997 (JWID97) is providing a means for JDISS to demonstrate its continued improvements to DoD in an integrated joint and coalition environment. JWID97 participation is important for the JDISS program since current COTS-based C4I systems are maturing and beginning to offer intelligence functionalities and low-end personal computers are running Windows NT and are beginning to be used in greater numbers for intelligence purposes. Other JWID97 participants need to know where JDISS is going with respect to the DII, how JDISS can already interoperate with Joint C4I systems and the capabilities of a JDISS NT workstation (DII-JDISS, 1997). The following JDISS JWID97 Demonstration Overview provided by the JDISS Program Office, ONI-7JD, outlines several new and unique special features and possibilities for the future.

The DII-based JDISS version 3.0 will be demonstrated as an integrated family of plug-in intelligence support and multimedia collaborative software segments based on the DII COE (version 3.0). COTS Multi Level Security (MLS) and Trusted Web technology will be used to securely exchange intelligence data and to provide coalition access to web-based products and data. Several variants of JDISS will be used, including JDISS 3.0 as a Sun Sparc-based intelligence research workstation, the new JDISS NT deployable workstation which utilizes the DII Windows NT core, and embedded JDISS segments within GCCS (version 2.2/3.0). Various intelligence analysis tools convey with JDISS to support imagery exploitation, access to intelligence servers, file transfers, analyst chatter, etc. JDISS 3.0 Sun Workstations will feature the Multimedia Collaboration Manager (MCM), a prospective enhancement to the DII in the area of collaborative analysis and planning.

Specific MLS solutions to be demonstrated include the JDISS Multiple Network Workstation (MNW), the JDISS Multiple Level Security (MLS) Trusted Web Server, and the Trusted Intelink Dissemination Access Server (TIDAS). The combination of these systems will be used to demonstrate point-to-point and multi-point dissemination
of intelligence from the U.S. and NATO to a Coalition (resident on the Coalition wide area network), and will allow participants on the SIPRNET to securely browse Web servers on the Coalition wide area network. The JDISS MSL Trusted Web Server will be connected to the SIPRNET, the NATO Linked Operations Centers, Europe, network, and the Coalition wide area network. This will provide a means for the MSL Webmaster to rapidly place Coalition-releasable U.S. and NATO information on a Web page accessible by any participant on the Coalition wide area network. The “low side” of the MLS systems will be audited by the Net Ranger COTS suite of intrusion protection hardware/software. The JDISS demonstration will also feature FORTEZZA user identification/authentication technology. (DII-JDISS, 1997)

As stated above, JDISS NT version 3.0 capabilities will highlight communications, data exchange and interoperability with UNIX-based JDISS version 2.0 systems. But additionally, JDISS NT will have COTS MLS and Trusted Web technology which will be used to securely exchange intelligence data and provide access to non-secure web-based products and data. This will ensure that future intelligence operators, collection managers, and fusion analysts, whether deployed or not, U.S., NATO or Coalition, can perform and collaborate their analysis and reporting for the benefit of the Joint warfighter and decision maker. This is a very important and required capability as JDISS moves toward the twenty-first century and should ensure that JDISS will continue to be an influential intelligence information technology program.
III. SUMMARY

JDISS provides access to timely, intelligence data for the decision-maker. It is capable of transmitting secure low bandwidth real or near-real time intelligence information simultaneously to multiple users using a variety of available communication pathways. JDISS performs real-time problem solving and analysis sessions with other JDISS users, transmits and receives data files, supports digitized imagery exchange and manipulation, establishes and maintains JDISS terminal links, enables secure communications between JDISS workstations and provides access to office tools and host applications. The JDISS program was developed to ensure that each of the U.S. services and agencies had an intelligence system which was compatible, a task that was accomplished by the use of common COTS standards assuring interoperability.

JDISS is considered the coordinated intelligence community-sponsored system to provide intelligence to the warfighter. As stated, the purpose of JDISS is to provide the foundation for achieving strategic to tactical intelligence interoperability. However, none of this is possible without trained JDISS users. The JDISS system design allows almost any user with basic typing and fundamental computer skills to access the system using a common GUI desktop and an integrated group of standard applications. These interactive applications and their functionality is the power of JDISS. The descriptive, step-by-step JDISS Guide was developed specifically to target new users without a JDISS background. The new user assisted by many instructive illustrations and images will be able to quickly learn and perform the basic operations listed above. The Guide focuses on four of the six JDISS applications. Two core applications (Communications and
Images), a pre-requisite application to the two core applications (the Desktop application), and a supporting application (the Utilities application). As JDISS global use continues to expand, it is anticipated that this guide for new users will benefit future JDISS users worldwide.
APPENDIX A: JOINT DEPLOYABLE INTELLIGENCE SUPPORT SYSTEM (JDISS) COMMUNICATIONS AND IMAGERY APPLICATION GUIDE FOR NEW USERS

This appendix is submitted in a separate article under the title “Joint Deployable Intelligence Support System (JDISS) Communications and Imagery Application Guide for New Users.” The purpose of including this appendix as a separate file is to facilitate its use as a user manual.
Joint Deployable Intelligence Support System
Communications and Imagery Applications Guide for New Users

19 June 1997

by
Major Marlon F. Brown
## APPENDIX A
TABLE OF CONTENTS

1 JDISS DESKTOP ................................................................. A1-1
  1.1 Desktop Operation ......................................................... A1-1
  1.1.1 Graphic Locator Device (Mouse/Trackball) ...................... A1-1
  1.1.2 Window Control Functions ............................................ A1-2
  1.1.3 JDISS Main Desktop Window .......................................... A1-3
  1.1.4 File Menus ............................................................... A1-6
  1.1.5 Pop-up Menus ............................................................. A1-7
  1.1.6 Permissions and Ownerships .......................................... A1-8
  1.1.7 Naming Files ............................................................. A1-10
  1.1.8 Storing Files ............................................................. A1-10
  1.1.9 Icons ................................................................ A1-10
  1.1.10 Shared Directory ......................................................... A1-11
  1.1.11 Trash ................................................................ A1-12
  1.1.12 Log Out Procedures ...................................................... A1-12
  1.2 Conclusion ................................................................. A1-13

2 JDISS COMMUNICATIONS APPLICATION .................................... A2-1
  2.1 Alert ........................................................................ A2-2
  2.1.1 Activate Alert ............................................................ A2-2
  2.1.2 Send Alert Message ..................................................... A2-3
  2.1.3 Save Alert Message ..................................................... A2-5
  2.1.4 Respond to an Alert ..................................................... A2-5
  2.1.5 Close Alert ................................................................. A2-5
  2.2 Chatter ........................................................................ A2-6
  2.2.1 Activate Chatter .......................................................... A2-6
  2.2.2 Begin Chatter Session .................................................... A2-6
  2.2.3 Save Chatter ............................................................... A2-10
  2.2.4 Invitation to Chatter ..................................................... A2-10
  2.2.5 Print Chatter Session .................................................... A2-13
  2.2.6 Iconify Chatter (NEVER De-Activate) ......................... A2-13
  2.2.7 Troubleshooting Chatter ................................................ A2-14
  2.3 JPings .......................................................................... A2-15
  2.3.1 Activate JPings ............................................................ A2-15
  2.3.2 Close JPings ............................................................... A2-16
  2.4 Collage ......................................................................... A2-16
  2.4.1 Begin Collage Session ................................................... A2-18
  2.4.2 Close Collage ............................................................. A2-18
  2.5 SLIP ............................................................................ A2-21
  2.5.1 Begin SLIP ................................................................. A2-21
  2.5.2 Close SLIP ................................................................. A2-22
  2.6 Jvox ................................................................. A2-23

A-i
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.6.1</td>
<td>Activate Jvox</td>
<td>A2-23</td>
</tr>
<tr>
<td>2.6.2</td>
<td>Initiating a Call</td>
<td>A2-24</td>
</tr>
<tr>
<td>2.6.3</td>
<td>Close Jvox</td>
<td>A2-25</td>
</tr>
<tr>
<td>2.7</td>
<td>XFTP</td>
<td>A2-25</td>
</tr>
<tr>
<td>2.7.1</td>
<td>Activate XFTP</td>
<td>A2-25</td>
</tr>
<tr>
<td>2.7.2</td>
<td>Connect to Hosts</td>
<td>A2-27</td>
</tr>
<tr>
<td>2.7.3</td>
<td>Close XFTP</td>
<td>A2-31</td>
</tr>
<tr>
<td>2.7.4</td>
<td>XFTP Preferences</td>
<td>A2-31</td>
</tr>
<tr>
<td>2.8</td>
<td>Send File</td>
<td>A2-35</td>
</tr>
<tr>
<td>2.8.1</td>
<td>Activate Send File</td>
<td>A2-35</td>
</tr>
<tr>
<td>2.8.2</td>
<td>Acknowledge Receipt</td>
<td>A2-37</td>
</tr>
<tr>
<td>2.8.3</td>
<td>Close Send File</td>
<td>A2-39</td>
</tr>
<tr>
<td>2.9</td>
<td>XMIT</td>
<td>A2-39</td>
</tr>
<tr>
<td>2.9.1</td>
<td>Applications XMIT Supports</td>
<td>A2-39</td>
</tr>
<tr>
<td>2.9.2</td>
<td>XMIT Application Interfaces</td>
<td>A2-40</td>
</tr>
<tr>
<td>2.10</td>
<td>Conclusion</td>
<td>A2-41</td>
</tr>
<tr>
<td>3.</td>
<td><strong>JDISS IMAGES APPLICATION</strong></td>
<td></td>
</tr>
<tr>
<td>3.1</td>
<td>ELT</td>
<td>A3-1</td>
</tr>
<tr>
<td>3.1.1</td>
<td>Activate ELT</td>
<td>A3-2</td>
</tr>
<tr>
<td>3.1.2</td>
<td>JDISS Imagery Formats</td>
<td>A3-7</td>
</tr>
<tr>
<td>3.1.3</td>
<td>Image Manipulation in ELT</td>
<td>A3-8</td>
</tr>
<tr>
<td>3.1.4</td>
<td>Saving and Converting Images</td>
<td>A3-19</td>
</tr>
<tr>
<td>3.1.5</td>
<td>Print an Image</td>
<td>A3-21</td>
</tr>
<tr>
<td>3.1.6</td>
<td>Conclusion</td>
<td>A3-22</td>
</tr>
<tr>
<td>3.2</td>
<td>Hippi</td>
<td>A3-22</td>
</tr>
<tr>
<td>3.2.1</td>
<td>Scanning an Image</td>
<td>A3-22</td>
</tr>
<tr>
<td>3.2.2</td>
<td>Saving an Image</td>
<td>A3-24</td>
</tr>
<tr>
<td>3.2.3</td>
<td>Printing an Image</td>
<td>A3-25</td>
</tr>
<tr>
<td>3.2.4</td>
<td>Conclusion</td>
<td>A3-25</td>
</tr>
<tr>
<td>4.</td>
<td><strong>JDISS UTILITIES APPLICATION</strong></td>
<td></td>
</tr>
<tr>
<td>4.1</td>
<td>Backup-Restore</td>
<td>A4-1</td>
</tr>
<tr>
<td>4.1.1</td>
<td>Backup to Magnetic Media</td>
<td>A4-2</td>
</tr>
<tr>
<td>4.1.2</td>
<td>Restore from Magnetic Media to Hard Disk</td>
<td>A4-2</td>
</tr>
<tr>
<td>4.1.3</td>
<td>Backup and Restore Characteristics</td>
<td>A4-3</td>
</tr>
<tr>
<td>4.1.4</td>
<td>Close Backup and Restore</td>
<td>A4-5</td>
</tr>
<tr>
<td>4.2</td>
<td>Calculator</td>
<td>A4-5</td>
</tr>
<tr>
<td>4.3</td>
<td>Calendar</td>
<td>A4-5</td>
</tr>
<tr>
<td>4.3.1</td>
<td>Open Calendar</td>
<td>A4-5</td>
</tr>
<tr>
<td>4.3.2</td>
<td>Close Calendar</td>
<td>A4-7</td>
</tr>
<tr>
<td>4.5</td>
<td>Clock</td>
<td>A4-8</td>
</tr>
<tr>
<td>4.5.1</td>
<td>Open Clock</td>
<td>A4-8</td>
</tr>
<tr>
<td>4.5.2</td>
<td>Set Alarm</td>
<td>A4-8</td>
</tr>
<tr>
<td>4.5.3</td>
<td>World Map/Time Zones</td>
<td>A4-9</td>
</tr>
<tr>
<td>4.5.4</td>
<td>Close Clock</td>
<td>A4-10</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------</td>
<td>------</td>
</tr>
<tr>
<td>4.6</td>
<td>DOS Tools</td>
<td>A4-10</td>
</tr>
<tr>
<td>4.6.1</td>
<td>DOS Copy</td>
<td>A4-10</td>
</tr>
<tr>
<td>4.6.2</td>
<td>DOS Format</td>
<td>A4-11</td>
</tr>
<tr>
<td>4.6.3</td>
<td>DOS Export</td>
<td>A4-11</td>
</tr>
<tr>
<td>4.6.4</td>
<td>DOS Import</td>
<td>A4-12</td>
</tr>
<tr>
<td>4.6.5</td>
<td>DOS Rename</td>
<td>A4-12</td>
</tr>
<tr>
<td>4.6.6</td>
<td>DOS Erase</td>
<td>A4-13</td>
</tr>
<tr>
<td>4.6.7</td>
<td>Eject Floppy Disk</td>
<td>A4-13</td>
</tr>
<tr>
<td>4.6.8</td>
<td>Close DOS Tools</td>
<td>A4-13</td>
</tr>
<tr>
<td>4.7</td>
<td>Shutdown</td>
<td>A4-13</td>
</tr>
<tr>
<td>4.8</td>
<td>Print Screen</td>
<td>A4-14</td>
</tr>
<tr>
<td>4.9</td>
<td>Project Manager</td>
<td>A4-15</td>
</tr>
<tr>
<td>4.10</td>
<td>System Load</td>
<td>A4-15</td>
</tr>
<tr>
<td>4.11</td>
<td>Save Screen</td>
<td>A4-15</td>
</tr>
<tr>
<td>4.12</td>
<td>CDROM</td>
<td>A4-16</td>
</tr>
<tr>
<td>4.13</td>
<td>Time Zone Clock</td>
<td>A4-17</td>
</tr>
<tr>
<td>4.14</td>
<td>Video Pix</td>
<td>A4-17</td>
</tr>
<tr>
<td>4.15</td>
<td>Soft Windows</td>
<td>A4-18</td>
</tr>
<tr>
<td>4.16</td>
<td>Disk Status</td>
<td>A4-18</td>
</tr>
<tr>
<td>4.17</td>
<td>Set Password</td>
<td>A4-19</td>
</tr>
<tr>
<td>4.18</td>
<td>Version</td>
<td>A4-19</td>
</tr>
<tr>
<td>4.19</td>
<td>Conclusion</td>
<td>A4-20</td>
</tr>
</tbody>
</table>
PREFACE

The JDISS Communications and Images Application Guide for New Users (Guide) approaches the problems of the new user in two ways: First, it provides an overview of the JDISS Desktop and utilities applications. In the JDISS Desktop section, the Guide discusses the standard graphical user interface (GUI) used on UNIX — X Windows. The new user is carefully guided through the basic functions and requirements of performing operations within X Windows with the specific purpose in mind of ensuring the user is comfortable with the desktop GUI, X Windows control functions, and the various sub-menus and pop-up menus that the user will experience. In the Utilities Applications section, convenient utility tools are provided which enable the user to expedite both local use to include file(s) manipulation and remote dissemination/retrieval of an assortment of products.

Second, the Guide provides detailed “new user” type instructions for the communications and images applications. The instructions, although not all-inclusive, are simply written with many supporting images depicting the program responses to the user’s inputs. Processes that require special knowledge, software, hardware, etc. or are beyond basic user needs, i.e., require advanced user knowledge, are not included and are not required for users to appreciate basic JDISS applications.

JDISS is considered the coordinated intelligence community-sponsored system for providing intelligence to the warfighter. As stated, the purpose of JDISS is to provide the foundation for achieving strategic to tactical intelligence interoperability across services. However, none of this is possible without trained JDISS users. The JDISS system design allows almost any user with basic typing and fundamental computer skills to access the
system through a common GUI desktop and an integrated group of standard applications. These interactive applications and their functionality are the power of JDISS. The descriptive, step-by-step JDISS Guide was developed specifically to target new users with no JDISS background. The new user, assisted by many instructive illustrations and images will be able to quickly learn and perform the basic operations listed above. As JDISS global use continues to expand, it is anticipated that this guide for new users will benefit future JDISS users worldwide.
APPENDIX A
SECTION 1
JDISS DESKTOP

JDISS uses a Graphical User Interface (GUI), a windowing environment, as the primary screen feature. The GUI allows users to select options, move and manipulate data, and receive and disseminate information worldwide. All JDISS functionality is accessed through the desktop window, and since this is achieved through the UNIX X Windows capability on a JDISS UNIX workstations, a general overview of X Windows is provided.

X Windows is the standard GUI used on UNIX systems such as SUN Sparc UNIX-based workstations. Like most UNIX applications, JDISS UNIX applications are hardware independent and may run on any platform that supports the X Windows environment. X.Desktop is an implementation of X Windows which is used on JDISS workstations. The X.Desktop part of X Windows provides a GUI environment which allows programs and files to be visualized as easily recognized pictures or icons allowing user input via point and click means. It also allows for customization or user organization of the Desktop to meet the specific needs of the user. (JBOC, 1996)

Additionally, X Windows supports the Client-Server Environment (CSE) that is designed to operate with multiple computers or processors cooperating together. The server can be set up to offer shared processing and storage with the individual client or workstation. In environments, such as JDISS, most files and information are stored on the central server and not at the individual workstation. The X Windows environment is also designed to operate well over remote communications links and networks, another important feature for JDISS program applications.

1.1 Desktop Operation

The JDISS program creates windows in response to icon, menu option or function key selections. Some windows are temporary, while other windows need to be displayed, minimized or active for the duration of a user's session. Since many windows can be open at the same time, the user tells the system which window he wants to view or manipulate by placing the cursor in that window. The system acknowledges the window selection by changing the color scheme of the active window.

1.1.1 Graphic Locator Device (Mouse/Trackball)

JDISS uses a graphic locator device as the primary input device. The locator, hereafter referred to as a mouse (trackball), is used whenever possible for input and control functions. The mouse minimizes keyboard entry to the system and lets the user
concentrate less on the keyboard entry input and more on the actual task to be accomplished. For JDISS applications, mouse must contain three buttons. These buttons perform different functions utilizing the pointer to select graphic objects, launch applications, invoke functions, or select options.

1. Left Button: The left button is commonly used to select menu options or objects on the display screen.

2. Center Button: The center button is normally used for cut and paste operations in single or multiple applications.

3. Right Button: The right button usually terminates functions or is used for pop-up menus within the system.

For the purpose of this Application Guide, all instructions that apply to the left mouse button will be noted by the single word "click" (or double "click"). If the instruction calls for clicking either the center or right buttons, the words "center mouse button" or "right mouse button" will be used.

1.1.2 Window Control Functions

By using the mouse and cursor-sensitive icons, each of the JDISS windows can be controlled by the following associated functions (see Fig. 1.1 for a sample window).

1. To activate a window, merely position the pointer with the mouse within the window.

2. To resize a window (change the height or width), place the pointer anywhere on the window frame except the corners, click and hold — the cursor will change from a northwest pointing arrow to an arrow that is pointing toward and touching the window frame. Keep holding the button and drag the window frame to expand or contract it to the desired position. When you are satisfied with the window size, release the button to freeze the window size.

3. To minimize a window (shrink a window to icon size), click on the window's minimize button. Minimize is used as a means of managing your desktop space. The minimize button is the dot symbol second from the right appearing in the upper right portion of any window.

4. To make a window fill up your entire screen (maximize), click on the maximize button. The maximize button is the square symbol located just to the right of the minimize button.
5. To scale a window (change the height and width at the same time), place the pointer on a window frame corner, click and hold — the cursor will change from a northwest pointing arrow to an arrow pointing into a corner. Keep holding the button and drag the corner to the desired position. The length and width of the window will change together as you drag the corner. When you are satisfied with the window size, release the button to freeze the window.

6. To reposition a window, place the cursor on the title bar, click the left or middle mouse button and drag the window to the desired location. Do not drag from the corners. The cursor will change from a northwest pointing arrow to four arrows pointing away from the mutual center. Keep holding the button while dragging the window to the desired position. When you are satisfied with the window position, release the button to drop the window at the current location.

7. Most windows incorporate at least one pulldown menu (list or function set) from which sub-functions can be invoked. A menu option is selected by placing the locator over the desired option and clicking. The menu also shows “Accelerator” key combinations that will invoke the window functions by using the keyboard instead of the mouse.

8. Windows will frequently overlap on another and may be brought to the foreground (top window) or sent to the background. To position the window, simply position the cursor within the window screen background (not the desktop free space) and click the right mouse button. This will bring up the Workstation Main Menu. Select Window Operations and a cascade menu will appear. Choose shuffle up or shuffle down depending on what you want to do. Also, simply clicking on any edge of a window will bring it to the foreground, shuffling other overlapping windows to the background.

9. To close a window either double click on the minus sign in the upper left corner or select File and Exit.

1.1.3 JDISS Main Desktop Window

The picture below shows the main components of the JDISS Main Desktop window, as it appears when you first open JDISS. It is a window where the user groups icons to organize his work.
Figure 1.1 (JDISS Main Desktop)

JDISS applications can also be selected using the workstation JDISS Main Menu shown below. To bring up the workstation JDISS Main Menu, place the cursor anywhere within the JDISS window screen background and click with the right mouse button.

There are sixteen options within the Workstation Menu for the typical JDISS user. The seventeenth option (ISSO Access) is only for a trusted user. The first ten options reflect the DoDISS/JDISS Desktop icons which are also displayed as icons on the JDISS Main Desktop window. This pop-up menu was developed as an alternative and quick way for users to initiate JDISS applications without having to bring the JDISS Main Desktop window back to the foreground.

Figure 1.2 (JDISS Main Menu)

All sixteen options on the JDISS Main Menu are discussed in the JDISS Help function. The Communications, Images and Utilities applications are also discussed in
detail later in the Application Guide. The last seven are not found as icons. Six of these seven options are very convenient for the new user (ISSO Access is for trusted users only). They are listed below as a ready reference for new user convenience.

1. Print: Utilized to print out standard ASCII files to either the local or remote printer depending on currently selected printer.

2. Printer Status: The printer status window shown in Fig. 1.3 allows the user to check the status of and manipulate all print jobs.

![Figure 1.3 (Printer Status)](image)

The printer status window has three sections. The top left corner shows a list of printers from which to select. The top right corner displays the status of the selected printer. The bottom window gives information on the different printer jobs.

(1) To update the printer status, select the Status pulldown menu and choose the Update option.
(2) To remove Jobs, select the Remove pulldown menu and choose either Selected Jobs or All my (your_login) jobs.
(3) To choose printers, select the Printer pop-up menu and choose either the real name or the alias for available printers.

3. Screen Lock: Will provide security of your terminal, allowing the user to leave the terminal without logging off. User must re-enter his password to unlock the screen.

4. Restart X.Desktop: Will restart the associated desktop with current session.

5. Window Operations: Provides the following cascade menu.

(1) New Window - Will bring up a terminal emulation (xterm) window allowing the user access to the UNIX command line.
(2) Shuffle Up and Shuffle Down - Is another way to move your windows around.
(3) Refresh - Redisplays existing windows.
(4) Restart MWM - Will restart your session as a Motif Window Manager (MWM) session if you are not already there. This option is used also to restart your session if refreshing the window was not enough to totally bring back your session to normal.


1.1.4 File Menus

For the general user, the JDISS Main Desktop window contains the following four pulldown menus:

1. File: The File pulldown menu lets you control the general operations of the objects on the desktops. The File pulldown menu items include:

   (1) Find - Used to search for specific files.
   (2) Save - Allows users to establish the look of their system desktop. The user can arrange the items in his work space in many different ways and then save this work space for future re-use using the save option. However, JDISS automatically overwrites the user’s desktop before launching it, therefore, modifications to the user’s desktop will only exist for the duration of the current login.
   (3) Save as - Saves a copy of the current desktop with a new name.
   (4) New Desktop - Creates a new, empty desktop.
   (5) Open Main Desktop - Opens the Main JDISS Desktop window.
   (6) Properties - This function is only available when at least one icon on the desktop is selected. If you remove the item using properties, the command will not delete the item from the system but it will be removed from the current window. If you remove an icon that is part of the Main Desktop, the next time you log in the item will be back in place.
   (7) Close All Directories - This option will close all open directory windows.
   (8) Close This Desktop - This option is used to close out the current desktop you are working on. This will not log the user out of the system.
   (9) Exit - Used to exit the Main Desktop.

2. Edit - The Edit pulldown menu provides functions for selecting and putting back icons.

   (1) Get Out - Is used on desktops only. The command is only available when at least one icon is selected. It allows the user to build a personal desktop without having to drag icons/files from one desktop to another. For example, to use Get Out,
select the Main Desktop icon(s) you need and then go to your personal desktop and choose get out and the icon(s) you selected will be placed into your personal desktop.

(2) Put Back - Works similar to the Get Out option. Select the icons you want to put back to the Main Desktop and choose Put Back and it will put the directories back into their original assigned locations.

(3) Select All - Selects all the icons on the desktop.

(4) Deselect All - Deselects all the icons on the desktop.

3. View - The View pulldown menu provides functions to determine how icons and directory windows will be displayed. The view menu also allows the user to change the layout of the icons.

(1) Icons - This is the default setting. Shows each file and directory as an icon.

(2) Names - Shows files, types of files and directories with their titles as mini-icons. The same operations can be performed with the mini-icons as can be performed with normal size icons.

(3) Clean-Up - Neatly reorganizes icons of the desktop.

(4) Reorganize - Reorganizes all the icons in the window, starting at the top left hand corner of the window. In the Main Desktop window, the icons will remain approximately in the same order as before.

4. Options - The Options pulldown menu provides functions for customizing X.Desktops.

(1) Main Desktop Preferences - Displays a cascade menu allowing the user to personalize the main desktop, color, font, patterns or configurations.

(2) Desktop Preferences - Operates in the same manner as the Main Desktop Preferences.

(3) General Preferences - Displays a cascade menu allowing you to personalize the dialogs, mouse, tools or devices.

1.1.5 Pop-up Menus

In addition to the pulldown menus available from the desktop and directory windows, the user can Pop-up Menus on the background of a desktop or directory. A Pop-up Menu shown in Fig. 1.4 provides exactly the same commands as the desktop menu bars.

1. To activate the pop-up menus, press the right mouse button within a desktop or directory window.
2. There are also Icon Pop-up Menus available. The Icon Menus "pop-up" whenever the user holds down the right mouse button on an icon. They provide the following functions relating to that icon.

(1) Activate - Activates the tools.
(2) Properties - Displays information about the icons.
(3) Copy to - Copies the icons to a specific directory.
(4) Move to - Moves the icons to a specific directory.
(5) Duplicate - Makes a second display of the icon in the directory.
(6) Rename - Renames the icon.
(7) Discard - Discards the icon by moving it into the trash icon.
(8) Configure - "Tools only"
(9) Check - Updates "pictures files only" in the memory cache.
(10) Help - Displays help information about the icon, if available.
(11) Stop - Stops a tool running, or closes the document editor

1.1.6 Permissions and Ownerships

For Security purposes, each user is required to have their own personal logon. Each file created under this logon is given certain permissions. The user can view selected permissions from the UNIX xterm window. Permissions are described below in Fig. 1.6.
1. The first letter is a UNIX file type which will commonly be either a "-" or a "d".

   (1) The "-" represents a plain text file.
   (2) The "d" represents a directory.
   (3) Other UNIX file types are available (see System Administrator or UNIX reference manual, e.g., Xdesktop User’s Guide).

2. The remaining portion describes the permissions available to:

   (1) Owner - The owner is usually the person that created the file. There may be only one owner.
   (2) Group - Each person having access to a login in a UNIX environment will belong to a group. Most persons that have access to JDISS will fall into the JDISS users group. The permissions assigned to this area will be defined for those personnel that belong to the same group as the owner.
   (3) All - This is for personnel that do not belong to the same group as the owner.

3. The permissions that are available are described below:

   (1) The "r" represents a read capability.
   (2) The "w" represents a write capability.
   (3) The "x" represents an executable capability, usually programs or directories will have an "x" in each area (owner, group and other). This provides permission to “x”ecute programs, directory access, mailing lists, etc.

4. Here is an example of a common file permission (see Fig. 1.7):

   (1) The UNIX file type is file (not a directory or something else).
   (2) The owner has read and write capability for that file.
   (3) The group has read only or copy capability, but can not save to the file.
   (4) All others have read only or copy capability.

   rwx rwx rwx

Figure 1.6 (Permissions)

5. As an added note, it is also necessary to check directory permissions when viewing file permissions, e.g. if the file is writeable, but the directory is not, writing to the file will not be permitted.
1.1.7 Naming Files

There are a few precautions you must take when naming files to ensure the file is saved correctly.

1. When naming a file in an application (e.g., ELT-2000, Applix, etc.), do not type the file extension (.pdf or .aw). The application automatically adds the file extension for you. If the user types an extension, the file will have a double extension (.pdf.pdf) when it is saved.

2. When naming a file in a directory window, the file extension must be added. This is because a utility outside of the associated application of the file is being used. The following information should also be noted:

   (1) Changing just the extension of a file name will not ‘convert’ that file. You must use an import or export function.
   (2) ELT-2000 allows twelve characters, including multiple ‘dots’ and some special characters.

1.1.8 Storing Files

When storing files on a JDISS workstation shared with other users, it is always best to keep user specific files in the users directory.

1. When creating any file, remember to save it to your login subdirectory, e.g., "/home/machine_name/login" directory.

2. Anytime after receiving a file in the /home/machine_name/share directories, remember to move the file to your /home/machine_name/login directory.

3. Remember to keep the share directories clear of your files to prevent the possible loss of your files and to keep the share directories as small as possible. The share directory is an excellent place to move files you make available to other users. This allows the user to maintain read only capability in personal files and directories.

1.1.9 Icons

The JDISS GUI uses two different types of icons.

1. A small rectangle (like the chatter icon usually located in the lower left corner of the screen). This type of icon represents an active window that is not
presently being utilized but may be needed in the future. A window in this type of display has been minimized but is still active.

2. A cursor-sensitive stylized drawing (like the larger icons used for selecting JDISS applications). This type of icon represents a system object (a file, directory or software program). However, the primary purpose of this type of icon is to provide a means to execute the application which the icon represents. For example, to use any of the JDISS applications, move the pointer over the appropriate icon and double click to activate the application (hold down the right mouse button for the icon pop-up menu and select activate).

3. Icons surrounded by brackets are called “drop zone” icons. By selecting files and moving them to the drop zone, you may launch the application with the file that you dropped. For example, the printer icon in Figure 1.8, below is a “drop zone” icon.

![Figure 1.8 (Icons)](image)

4. The functions for manipulating icons are fairly simple.

(1) To select an icon, click once.
(2) To initiate that icon, double click.
(3) To move the icon, click and hold, then drag it to where you want to put it (trash, desktop, directory, etc.).
(4) To rename an icon (other than a system file), double click on the name below the icon, the area will highlight and the cursor will appear. Make your changes and click in the white space off the name to close.

1.1.10 Shared Directory

The Shared Directory icon found on the JDISS Main Desktop window that looks like a file drawer allows the user to navigate and access the files and directories held in the Shared Directory tree. To access a file directory:

1. From the JDISS Desktop window double click on the shared directory.
2. Double Click on the directory you wish to access, e.g., /Documents or /Images.
3. Select the filename you wish to manipulate and double click on the icon. This will initiate the software package associated with the file and load the file automatically.
1.1.11 Trash

The Trash icon found on the JDISS Main Desktop window that looks like a small trash can allows for the deletion or recovery of files. Once a file is placed into the Trash icon, it is not deleted automatically but is stored there temporarily (the Trash icon will fill up with paper). The file may be re-placed into the directory from which it originated or be permanently deleted.

1. To place a file in the Trash icon:
   
   (1) Select the file you wish to delete.
   (2) Click and drag the file to the Trash icon and release it when the hand is highlighted.

2. To recover the file:
   
   (1) Double click on the Trash icon.
   (2) Select the file you wish to recover and click on the Restore option under the File pulldown menu or click and drag the file back to its original location.

3. To delete the file:
   
   (1) Double click on the Trash icon. Select “Empty” from the File pulldown menu inside the Trash icon.
   (2) Once the file has been emptied from the Trash icon, there is no possibility of recovery. In the UNIX environment, the remove command is considered FINAL or IRREVERSIBLE. Be sure you do not want a file anymore before conducting a deletion.

1.1.12 Log Out Procedures

The JDISS application software keeps an audit trail of each user and the functions that are performed while that user is logged in. For this reason, users should log out at the end of their session. However, before logging out, save any changes that were made to the application being worked in or they will be lost.

1. Ensure that the cursor is in the screen background of the JDISS Main Desktop window and bring up the workstation JDISS Main Menu by placing the cursor anywhere within the JDISS window screen background and clicking with the right mouse button. Select Log Out.
2. The system closes down the JDISS environment and returns to the Login Prompt.
1.2 Conclusion

Once installed, the JDISS applications are fully functional and can be activated by double clicking on their respective icons. The default settings provided during system installation will meet most user’s and site’s needs. The JDISS application software keeps an audit trail of each user and the functions that are performed while that user is logged into the system. If the user experiences problems during the session or an application does not perform, the user can refer to the CSE Console Window for any displayed system messages or error messages. Normally the CSE Console Window appears in the bottom right hand corner of the screen upon login.

This section on the JDISS Desktop lays the foundation for the rest of the Guide since all JDISS functionality is accessed through the JDISS Main Desktop window. It is important for the user to be comfortable with the look and feel of the Desktop before continuing. Subsequent sections and their descriptions of JDISS applications are based on the user’s working knowledge of the GUI.
APPENDIX A
SECTION 2
JDISS COMMUNICATIONS APPLICATION

The purpose of the Communications application is to provide several means of communicating with other JDISS locations. Chatter and Secure Voice (Jvox) provide user-to-user, interactive communications while Send File and XFTP primarily transfers files between JDISS users. Alert provides a short critical message capability while JPings tests the communications pathway for connectivity. And Collage provides an interactive white board utility. All of these will be discussed in more detail in this section. The following icon is the JDISS Communications icon.

Figure 2-1 (Communications Icon)

To access the Communications Desktop window from the JDISS User Main Desktop, double click on the Communications icon. The Communications Desktop window below allows icon selection of sub-programs. The programs will be discussed in the icon order shown.

Figure 2-2 (Communications Desktop Icons)
Alert is used for sending short, high priority messages that demand immediate attention to another JDISS machine. There are two types of alerts: Send Alert and Send Registered Alert. The only difference is Send Registered Alert returns an acknowledged window to the sender.

2.1.1 Activate Alert

To access Alert, double click on the Alert icon in the Communications Desktop window. The below Send Alert window will appear.

![Send Alert Window]

**Figure 2-3 (Send Alert)**

1. The Send Alert window is broken into three sections.
   
   (1) The Message Area where the user enters the message information to be sent.
   
   (2) The Reply Area which contains the responses sent by a remote user.
   
   (3) The Status Area which gives the user the status of the alert.

2. Alert has three pull-down menus.
(1) File menu contains:
   a. Open File: Loads an ASCII file into the message area.
   b. Save Reply: Saves the text within the reply window.
   c. Disconnect from Host: Allows the user to disconnect from the
      host the user is currently communicating with.
   d. Quit: Exits the Alert Application

(2) Send menu contains:
   a. Send Alert: Sends the Message area text to a remote machine.
   b. Send Registered Alert: Sends a registered alert to a remote user.

When remote user acknowledges the alert message, an Alert Acknowledgment window is sent back to the originator.

(3) Help menu: Provides on-screen help instructions.

3. Alert has three command buttons.

   (1) Send and Send Registered: Both perform the same functions as the
       pull-down file menus.
   (2) Clear: Allows the user to clear the message area. This is especially
       useful when the user has another message to send.

2.1.2 Send Alert Message

To send an Alert, follow the following steps:

1. Click in the “Enter Message Here” portion of the Send Alert window — type a message.

2. OR, instead of typing a new message the user may load an ASCII message into
   the message area by clicking on File and selecting Open File. Select the desired file from
   the Select File dialog window and click on OK. The ASCII file will load in the “Enter
   Message Here” window.

3. Select the site to receive the alert message by clicking with the left mouse
   button on the Send or Send Registered button in the middle of the Send Alert window, or
   by using the Send pull-down menu and selecting either Send or Send Registered. The
   rConnect_popup window appears as shown below.
4. Make a selection from the list of logged on users by either double clicking on the host name, or by clicking once to highlight the host name then clicking with the left mouse button on the OK button at the bottom left corner of the window.

5. If you selected to send the Alert Registered format, the system at the distant end will receive the Registered Alert window, shown below.

6. Once the distant end acknowledges that the alert was received, the sending system receives a Registered Alert Acknowledged window, shown below.
2.1.3 Save Alert Message

To save Alert Messages, follow the following steps:

1. From the Send Alert window, click on the File pull-down menu and select Save. The Select Directory Pop-up window opens.

![Select Directory Pop-up](image)

Figure 2-7 (Select Directory Pop-up)

2. Enter the path and filename of the alert message to save. Click OK to save the file and close the window.

2.1.4 Respond to an Alert

To Respond to an Alert, perform the following.

1. From the Send Alert window, click in the Enter Reply Here area and type a response message.

2. Click on Send to send the response.

2.1.5 Close Alert

To close the Send Alert window, click on the File pull-down menu and select Quit. The Send Alert window closes and the distant end receives the following Alert termination window.
2.2 Chatter

Chatter allows informal text communications between multiple JDISS users worldwide to assist in real-time problem solving, analysis, and dissemination issues.

NOTE:
Chatter MUST be active on the receiving end to establish a chatter session.

2.2.1 Activate Chatter

To access Chatter, double-click on the Chatter icon in the Communications Desktop window. The desktop Chatter window opens as seen below.

Figure 2-9 (Desktop Chatter v2.0.1)

1. Chatter has three pull-down menus.

   (1) File menu.
a. Rolodex - Rolodex Manager window allows the user to easily manage a list of users that are contacted often. It also allows the user to add, delete and modify Chatter or Talk users.

1. A user is identified by a user name, host name and nickname in JDISS v2.0.
2. A Talk user is JDISS v2.0 talking to JDISS v1.02 or v1.01.

b. Exit - Lets you exit Chatter.

(2) Preferences menu.

Will display a menu of chatter characteristics that the user can control. In general, these preferences define how Chatter will answer incoming calls, whether log files are kept, whether dialogs should show system files, and when Chatter should update the list of active chatter users. The Preferences menu contains:

a. Answering Mode - Is a dialog that allows the user to specify what action to take when another Chatter user attempts to contact him. See below.

![Answering Mode](image)

**Figure 2-10 (Answering Mode)**

1. The user can have a conference automatically accepted or rejected with or without asking the user.
2. The user can set a time limit which when expired will execute the configured action. Minimum time is 5 seconds, maximum time is 90 seconds.
3. After the user has made his desired configuration, click on Save and then OK.
b. Logging - Allows the user to maintain a log of who has tried to call, who the user has tried to call, as well as, other system messages.

![Desktop Chatter Logging](image)

**Figure 2-11 (Desktop Chatter Logging)**

1. Default directory for your log file is "/tap" but the logging dialog allows the user to designate the directory where the user wants the log files to be placed.

2. Disable logging means the user does not want log files to be kept.

c. Monitoring Interval - Allows the user to specify how often Chatter should check for the existence of other Chatter users.

![Monitoring Interval](image)

**Figure 2-12 (Monitoring Interval)**

1. All the Chatter users in your Rolodex have monitor flags associated with them. If ‘ON’ (enabled) is set, then every “#” minutes Chatter will check for the existence of this user. If ‘OFF’ (disabled) is set, then no monitoring will be done regardless of the monitor flag.

d. Send Sequence - If enabled, will treat the 'sequence' of characters as equivalent to selecting the Send button when in a conference. If not enabled then the send sequence will be stripped off before the data is sent.
e. Conference Name - The user can assign a default name to use for each conference you start. This default name will be used to populate the conference name entry field in the invite dialog.

f. Audio - Allows the user to define how he is to be notified when someone invites him to chatter. Enabling this option will cause Chatter to beep when the user receives an incoming call.

g. Confirm Data Loss - On exiting a conference, Chatter will prompt the user if the chatter conference has not yet been saved.

1. Enabling this option will notify the user that the chatter conference data has not been saved.
2. Disabling this option will cause Chatter to silently discard the data.

h. Send on “<Return>” - Enabling this option will treat the “<Return>” key equivalent to selecting the Send button when in a conference. The option will send the line typed after each “<Return>” instead of waiting till the message is finished and clicking Send.
i. Show Hidden Files - Allows the user to define whether or not he wants file browser dialogs to show system files, or 'dot' files. Enabling this option will provide a listing of every file in a selected directory.

(3) Help button provides on-screen help advise.

(4) Command Buttons will be explained during the following discussion of how to use Chatter.

2.2.2 Begin Chatter Session

1. To begin a Chat session, double click on the Chatter icon — the desktop Chatter v2.02 window below will be displayed.

![Desktop Chatter V2.02](image)

**Figure 2-15 (Desktop Chatter V2.02)**

2. Click on the Invite button. Invite is where the user selects other users he wants to chatter with. The Invite to a new conference window opens. There is a list of users, and their chatter type and status.

![Invite to a New Conference](image)

**Figure 2-16 (Invite to a New Conference)**

(1) Within this window there are three icons shown by the arrows.
a. The Custom window icon selects which chatter protocol to use. As shown in the window below, JDISS v2.0 accommodates Chatter, DITDS, and Talk protocols.

![Custom Invite to a New Conference](image)

**Figure 2-17 (Custom Invite to a New Conference)**

b. Area Manager window icon enables customizing of chatter for specific site needs.

![Area Manager Invite to a New Conference](image)

**Figure 2-18 (Area Manager Invite to a New Conference)**

c. Hosts Invite window icon is used to query host for logged in users.
(2) Click on the Hosts Window icon. The Hosts Invite window opens. Enter the host name in the Hostname entry area or Click on one of the hosts listed, then select the Query command button to see which users are logged in. The User@Host listbox is populated with users based on the query.

![Hosts Invite to a New Conference](image)

**Figure 2-19 (Host Invite to a New Conference)**

a. The User@Host field appears on the right side of the window. Click to highlight the address of the requested chat session, then click OK. The hosts invite window closes, and the User@Host address appears under the Invite List of the Invite to a new conference window.

b. To select multiple users, press the CTRL key on the keyboard and click over the entries in your Rolodex list.

c. Click on OK to initiate a chatter session. The Invite to a new conference window closes, and the New session window opens.

![New Session](image)

**Figure 2-20 (New Session)**

3. The user can now start a chat session by typing in the lower portion of the window. Always start by identifying yourself, i.e., “This is Capt Drew…” then continue with the message. This is especially important if there are several user invites in the Chat session.
2.2.3 Save Chatter

1. To save the chatter session, click on the file pull-down menu in the New Session window and select Save As.

![Save Chatter Buffer As](image)

**Figure 2-21 (Save Chatter Buffer As)**

2. Use the directory display to specify the path where the file is to be saved. Click in the Filename area and type a filename.

3. Click OK to save the chatter session to the specified directory.

2.2.4 Invitation to Chatter

1. If the user is on the receiving end of a Chatter invitation, the user will receive the Invitation to Conference New Session window below. The user can either click on Accept to start a chatter session or click on Reject to end that Chatter Session.

![Invitation to Conference New Session](image)

**Figure 2-22 (Invitation to Conference New Session)**
NOTE:
If the site the user is trying to reach does not have the contacting user's machine listed in their host table, the user will be unable to talk with them (See 2.2.7, Troubleshooting Chatter).

2.2.5 Print Chatter Session

1. To print a Chatter session from the New Session window, click on the File pull-down menu and select Print. The below Print window opens.

![Print Utility](image)

Figure 2-23 (Print Utility)

2. Select the desired features and click Print.

2.2.6 Iconify Chatter (NEVER De-Activate)

1. To quit a chatter session, you should first let the other participants know that you are going to disconnect. Following notification, click on the file pull-down and choose Leave Conference.

2. To leave Chatter, click on the minimize button in the upper right hand corner of the desktop Chatter window, the session is ended and the Chatter icon will appear in the lower left corner of the JDISS window. Never de-activate Chatter because other users will not be able to invite you to a Chatter session. NOTE: The default for a newly opened JDISS Desktop window for Chatter is active with the Chatter icon located in the lower left corner of the JDISS window.
2.2.7 Troubleshooting Chatter

1. The following Chatter information is added for troubleshooting and determining the meanings of various responses when trying to chatter. The message will be listed in **bold** with an explanation and action gauge following (action gauge, if more than one, is in the same order as the explanations):

   (1) **Message:**  **Unavailable**

   a. The Unavailable message means either no one is logged on, chatter is closed, or no communication links are available.

   b. **Solution:** First ‘ping’ the machine to check communication path. Second, try the query option to see if anyone is logged on and then send an E-Mail asking the user to open Chatter and remind him to keep Chatter open. Third, Contact them via another method, i.e., telephone, radio, etc., to have the user log on. If no communication links are available, call the Communication trouble-desk to correct link problem.

   (2) **Message:**  **Invited**

   a. The Invited message means that the user has chatter open and that a message is being displayed on the other machine that is inviting them to join a Chat session.

   b. **Solution:** This is a wait and/or send an email situation. The problem is the other user is either away from his machine or is too busy to accept the invitation. If they do not answer after a pre-set period, the invitation will timeout and you will get a status of declined. Following a timeout, the user may send an email. The user can also remind the other user to enable the Audio function so that he is notified whenever there is a Chatter Invitation waiting.

   (3) **Message:**  **Declined**

   a. The Declined message means that the invited user declined or that the chat session timed out, i.e., the other machine was invited, but no one responded. This happens fairly quickly if you are trying to chatter with v1.01 and will eventually happen with a v2.0 machine.

   b. **Solution:** Send an E-Mail.

   (4) **Message:**  **Chatter Error**
a. The Chatter Error dialog window appears when the host name you entered is not valid or there is no communication link to that machine. For the former, the user is not in your host table and/or he is not in the DNS server.

b. Solution: Recheck the host name. The IP address may have to be entered in the Host Table if the machine is not on a DNS server. In the case of no comm link, wait until communications have been restored. Additionally, the user can ‘ping’ the system to determine if communication links are down. The user can use both the IP address and the system name to ping. If the IP address pings good but the system name does not, then the user either has the wrong system name, DNS extension or it is not on the DNS server.

c. In order to determine if a machine name and DNS extension (i.e., dia-oicc1.dia.ic.gov, centcomiw1.centcom.ic.gov) is valid, enter this in the Other window of Pings and see if you get a response. If the response is “host unknown,” it is not valid.

2.3

The JPings function is used to check the connection between the user’s terminal (host or machine) and other JDISS terminals. Additionally, it is used as a communications troubleshooting tool. If the user experiences problems communicating with another site, JPings can tell whether the user’s terminal can ‘see’ the intended recipient.

2.3.1 Activate JPings

1. To use JPings, double click on the JPings icon in the Communications Desktop window and the JDISS Pings window will appear.
2. Select the host you wish to ping by highlighting the hostname with the mouse button.

3. Start pinging by clicking on the File pull-down menu and selecting Start JPings or double click on the hostname. The lower portion of the window displays the JPings status.

   (1) A successful ping shows a green 'GO' circle.

   (2) An unsuccessful ping shows a red 'NO GO' circle, then the 'Did not connect circle.'
2.3.2 Close JPings

After JPings has checked connectivity, click on the Dismiss button to close the Ping status window.

2.4 Collage

Collage provides a whiteboard service between JDISS v2.0 (or higher) systems for sending screen grabs, images, graphics and text, as well as, providing a corresponding chatter capability.

2.4.1 Begin Collage Session

1. To access Collage, double click on the Collage icon in the Communications window and the Collage window below will appear.

Figure 2-27 (Collage)
2. Enter the name of the host machine that you are logged into and select OK. A list of hosts participating in the session is displayed in the Participants' part of the main window. The current host will be the only user listed.

![Collage Version #](image)

Figure 2-28 (Collage Version #)

3. Click on the Collaborate pull-down menu and select Begin Session. The following window opens.

![Begin Session](image)

Figure 2-29 (Begin Session)

4. Enter the local hostname in the Your Name area. Collage will scan and pick an unused port to be used during the session. First you must enter a random port number (example 7890). This number must be between 1024 and 65535. After entering the number, click on OK. An Information window displays a message that a connection has been established with the Collage server.

![Information](image)

Figure 2-30 (Information)

5. Select OK and the window closes. At the distant end(s), the other user(s) repeat steps 1 and 2. From the Collaborate pull-down menu, select Join Session and the following window appears.
6. The remote user(s) should enter the name of the host which started the session in the Host name of the Collage server field and '7890' in the Server port number field. Click on OK. The two (or more) terminals are now interactively linked.

7. Any linked user can click on Window menu and select White board. The Public Whiteboard window opens. If Collage is connected between two systems, then the drawing or text appears at the distant end as they are drawn or typed on the local machine.

8. Select the pencil icon button in the Whiteboard window. Click and drag inside the large white box area. Lift up on the mouse button after dragging a few inches. A line is drawn in the white box area. The line drawn displays on the other host as well.

9. Repeat on the remote host to observe the box being drawn on the local host. Several activities can be done interactively to include a chat session.

10. From the Tools pull-down menu in the Collage main window, select Screen Capture. The mouse pointer changes shape. Move the mouse to the corner of the image
or screen view to be captured and sent. Diagonally drag the mouse over the entire area to be captured. Release the mouse to end the capture session. A collage window appears with the screen capture/image. If interactively connected, collage also sends a copy to the distant end of the collage session.

2.4.2 Close Collage

1. When ready the remote host can click on File and select Quit. The remote host’s main window closes ending the Collage application. The remote user’s name disappears from the Participants’ area of the main window on the local host. The collaborative/sharing session with the remote host has ended.

2. The local host can then click on File and select Quit. The main window closes ending the Collage application.

2.5 SLIP

The purpose of SLIP (Serial Line Internet Protocol) is to provide the user with an alternate means of communicating with distant JDISS systems in the event the network goes down. The most common alternative pathway when using SLIP is a dial-up modem over STU-III. SLIP requires that both users work together to establish communications and is basically a serial port to serial port connectivity. There are only two JDISS applications that will work with SLIP: JPings and Chatter.

2.5.1 Begin SLIP

1. Start SLIP by double clicking the SLIP icon on workstation #1. The first window that pops up asks you for the SLIP IP Address of the Local Machine. Use the default values that appear in the window.

![Figure 2-33 (SLIP: Workstation #1)]
2. For workstation #1, enter the SLIP IP address of the local machine (example 128.28.3.1). Click OK. The user can use the JDISS Manager to verify IP address if not known.

   (1) Enter the SLIP IP address of the remote machine (example 128.28.3.2).
   Click OK.

   (2) Enter the SLIP IP address of the distant machine.
   (3) Enter Baud rate, e.g., 9600.

3. Make sure to cross check IP addresses. The local IP on system one is now the remote IP on system two.

4. For workstation #2 enter the SLIP IP address of the local machine (example 128.28.3.2). Click OK.

![Figure 2-34 (SLIP: Workstation #2)](image)

   (1) Enter the SLIP IP address of the remote machine (Example 128.28.3.1). Click OK.
   (2) Enter the IP address of the distant machine.
   (3) Enter Baud rate.

In the JDISS console window you should see something like “add host 199.98.x.x gateway 128.28.3.2.” This means you have established a SLIP connection. The SLIP connection will work via serial port to serial port. A null modem cable with all 25 pins can be used to test.

2.5.2 Close SLIP

Either workstation can select File from the main menu and then Quit. The window closes ending the SLIP connection at both ends.
2.6 Jvox

Jvox (Interactive Packet Voice Terminal -- JDISS Secure Voice) provides an interactive method between locations to exchange voice messages in a secure manner. In order to receive incoming calls, the Jvox window must be either open or iconified on the screen. Jvox may be configured for either full or half duplex operations.

2.6.1 Activate Jvox

1. To access Jvox, click on the icon in the Communications window and the Interactive Voice Terminal window below appears.

![Image](/apt/jvox/jvox-v2.0.png)

Figure 2-35 (/apt/jvox/jvox v2.0)
2. Before making a secure call, the following steps must be followed to configure
the application before activation. Click on the Configure button, the Configure window
opens as shown below.

![Jvox Configure Pop-up](image)

**Figure 2-36 (Jvox Configure Pop-up)**

1. Click on the Vocoder pull-down and select ALP2400 (Adaptive 2400 baud).
2. Select Software by clicking on the control button upper right corner of window.
3. Slide the Vocoder Frames per Packet selector to select how many frames per packet you, the user, desires. The more frames you choose, the clearer your voice will be received at the distant end.
4. Select either Real Time (as you speak) or Non-real Time (delayed slightly or if poor communications exists) from the Playback mode.
5. For the Comm Mode, select either Full Duplex (this is preferred mode because the user can transmit and receive simultaneously with the distant end) or Half Duplex (only transmit or receive can be accomplished at a time).
6. The PTT (Push to Talk) is defaulted to Toggled.
7. Following the desired selections, click on OK, the Configure window closes and returns to the Jvox main window.

2.6.2 Initiating a Call

1. To initiate a call click in the Remote Party area of the Jvox main window.

   1. Enter the remote user_id@hostname (Distant end name@Distant end machine name), then click on the Call button.
   2. The Jvox window displays the status for “Called...” If the called station does not respond within 30 seconds, the status in the Jvox window changes to “Idle” (Timed out, no response).
2. When the distant end accepts a call by clicking on the Accept Call button in the window that appears, a Call Reply is sent to the originator. A display for Connected status appears at both ends. In full duplex mode, either party may click on the PTT button to send voice. In half duplex mode, only one party at a time may talk, then use PTT to send voice to the distant end. A 30 second timer initiates once the PTT is depressed.

![Accept Call | Reject Call]

Figure 2-37 (Accept/Reject Call)

2.6.3 Close Jvox

When the users are finished with their conversation and want to terminate the call, either party can click on the End Call command button and the session will end.

![XFTP]

XFTP (JDISS File Transfer Protocol) provides the capability of sending files between stations using the UNIX File Transfer Protocol (FTP).

2.7 Activate XFTP

1. To access XFTP, double click on the XFTP icon in the Communications Desktop window. The below XFTP File Transfer Utility window appears.

![Figure 2-38 (LLNL.XFTP)]
2. XFTP is a graphical user interface to Unix’s FTP. XFTP does not execute the local FTP program; instead, it directly communicates with the remote FTP servers. XFTP is an X client and follows the OSF/Motif look-and-feel. XFTP enables users to transfer files and perform various directory manipulation commands, both remotely and locally.

3. XFTP’s main window is divided into four main sections.

(1) The Main Menu Bar.

   a. File menu.

      1. About XFTP - displays information about this version of XFTP.
      2. Quit - which terminates the application.

   b. Log menu.

      1. Clear Log - Clears the diagnostics log window.
      2. Save Log - Writes the contents of the diagnostics window to a user-specified file. The existing contents of the diagnostics window are not removed.

   c. Options menu.

      1. Preferences - displays the user preferences.
      2. Viewer Preferences - displays the viewer preferences dialog.
      3. Save Preferences - saves the current settings of the user and viewer preferences.

(2) The Diagnostics log, at the bottom, displays error messages and status information. If the status flag indicates that an error has occurred, refer to the diagnostics window for the details.

(3) The file transfer controls in the center are Xfer Ops and Xfer Mode.

   a. Xfer Mode allows the user to select the desired file transfer mode by clicking the toggle button on ASCII or Binary (Use ASCII for plain text files and Binary for all other files).
   b. Xfer Ops has:

      1. Copy button that transfers the selected files according to the mode specified in Xfer Mode.
2. RCopy (Recursive Copy) button will transfer the user's selection only if it is a directory. The RCopy will transfer the entire selected directory sub-tree.

3. View, if selected under Xfer Ops, the file selected can be monitored during the progress of the transfer.

Remember the file is transferred according to the mode specified in Xfer Mode

(4) The host sections are located on either side of the file transfer controls. XFTP can be connected to one or two hosts. The hosts may be any combination of local and remote hosts (the local host is the client host where XFTP is running). Each host section consists of four major elements.

a. Connect menu - contains commands for connecting/disconnecting local and remote hosts.

b. Dir menu - contains various commands for creating new directories, changing and displaying the current directory.

c. Select menu - contains commands for selecting/deselecting entries in the current directory (the selections appear in the scrollable list of directory entries).

d. Ops menu - contains several commands that operate on selected directory entries.

2.7.2 Connect to Hosts

1. To get started, use the Connect menus to connect the two sides to the desired combination of local and/or remote hosts.

2. Choose local or remote on the left Connect. If you choose local, your (local user) choices will be listed in the left Directory pull-down menu bar.

3. Choose local or remote on the right Connect. If you choose remote, the dialog window prompting for host names, user names and password appears.

4. From the Connect to Remote Host window, click on the desired host, then click on Connect. The below window appears.
Figure 2-39 (Connect to Remote Host)

5. From the User Name window, enter your (the user) name to log onto the remote system. Click OK when done and if the connection between the two systems is up the following window will display.

Figure 2-40 (Enter User Name)

6. Click in the Enter the User Name area to activate cursor and type your login for the remote system. Click with the left mouse button on OK. The system responds by requesting a password for the specified login name on the remote system as shown in the window below. When done, click OK.

Figure 2-41 (Password)
7. Once the correct password for the specified login account has been entered, the XFTP window displays the connection to the remote system on the left side of the XFTP window (The user could have chosen either left or right Dir's -- files can be moved in either direction).

![Image of XFTP window]

**Figure 2-42 (LLNL.XFTP)**

8. Once connected, traverse through the host's directory structure by doing one of the following.

   1. Using the Directory Name menu (the menu just above the directory list).
   2. Double-clicking on entries in the directory list.
   3. Selecting an item in the Go to Previous Directory sub-menu in the host's Dir menu.
   4. Selecting the Change Directory item in the host's Dir menu.

9. Choose the Dir pull-down menu. Select Change Directory and change to different directories on the remote system. Make Directory provides a method of creating sub-directories on the remote system within the permissions set for the specified user login account. This is an interesting feature and one to remember when setting your permission set.

10. You can obtain different types of views into a host's current directory by selecting either the Display Directory (Long) listed in the host's Dir menu (this long listing is for display and not selection) or the Display Directory (Table) listed in the host's Dir menu. Both selections are shown below.
11. From the right side of the XFTP window, click on the Connect pull-down menu. Select Connect to Local. The contents of the listed directory for the local system is displayed.

12. Highlight the specified file(s) in either the remote or local machine by clicking on the filename(s) with the left mouse button. Once the files are selected, click on the Xfr (transfer) Mode radio button to select either ASCII or Binary mode (use ASCII for plain text files and Binary for all other files).

13. To transfer the file(s), click on the Copy or RCopy under the Xfer Ops in the middle of the XFTP window to transfer selected files. The Verify Selection confirmation window displays. Select OK to transfer the selections.
14. The File Transfer window provides an Abort button to cancel the file transfer. File transfer status displays in the lower portion of the XFTP window. Successful file transfer displays the file size transferred in a specified length of time. Errors in transfer are also noted in the lower portion of the XFTP window.

15. Verify the file was transferred by viewing the contents of the target directory in the XFTP window. The FTP'd file(s) should now appear under the target directory.

2.7.3 Close XFTP

To exit XFTP, click on File pull-down and select Quit. The session windows close.

2.7.4 XFTP Preferences

XFTP Preferences displays a dialog which allows the user to configure XFTP according to his preferences, shown below. There are numerous menu items associated with XFTP. Following is a list of the Options pull-down menus. The new user can leave Preferences at the default values.

![XFTP Preferences Dialog]

Figure 2-46 (XFTP Preferences)

1. The user is presented with a number of configuration parameters, which are set by either toggling, sliding or typing.

   (1) Apply - causes the new values to take effect.
   (2) OK button - has the same effect as Apply, but the dialog is also closed.
(3) Cancel - undoes any changes made since OK or Apply were last selected.

2. The preferences can be preserved across XFTP sessions in a text file named ".xftprc" in the user’s home directory. The user may alter the order in which the preferences are presented in the dialog by the following:

   (1) Terminating XFTP.
   (2) Using a text editor to change the order of lines in ".xftprc".
   (3) Restarting XFTP.

3. Add To Cache - Specifies whether newly referenced items should be added to the directory, quoted command, wildcard, and host/user caches. It is usually desirable to choose Yes. Choose No if referencing a series of seldom-referenced items that would clear the cache of your favorite entries.

4. Anonymous FTP Password - Initializes the Pass word field of the Connect to Anonymous dialog if accessible via each host’s Connect menu.

5. Beep When Ops Done - Specifies whether to beep when each set of deletion, move, quoted command, and file transfer operations completes.

6. Diagnostics - Specifies the level of diagnostics information to be written to the diagnostics log window. Choose one of the following.

   (1) Quiet for error messages only.
   (2) Normal for error messages and success messages.
   (3) Verbose for error messages, success messages, and replies received from the FTP servers.
   (4) Debug for error messages, success messages, commands sent to the FTP servers, replies received from the FTP servers, and other assorted diagnostics.

7. Directory Cache Size - Is the maximum number of previously referenced directory paths cached per host. The cache is preserved across XFTP sessions.

8. Enhance Colors - Specifies whether to enhance the appearance of some of the graphical elements (such as scrolled lists and text fields) by changing the normal background colors. This preference has no effect on monochrome displays. Choose Yes to enhance the appearance, or No for the usual Motif look.

9. Enter Dir Upon Creation - Specifies whether to automatically enter a newly created directory.
10. Host Cache Size - Is the maximum number of host to cache items. The cache is preserved across XFTP sessions.

11. Initial Logfile Name - Is the default file name to be presented to the user in the Save Log dialog.

12. Initial Transfer Mode - Is the default file transfer mode (ASCII or Binary).

13. Initial Wildcard Mode - Is the default mode of the User Wildcard dialog.

   (1) Choose Replace to make “Replace Filename Selection” the default.
   (2) Choose Add to make “Add to Filename Selection” the default.

14. Inquire On Copy - Specifies whether to pop up a dialog that asks the user to confirm that the indicated transfers should take place.

15. Inquire On Delete - Specifies whether to pop up a dialog that asks the user to confirm that the indicated deletions should take place.

16. Inquire On Move - Specifies whether to pop up a dialog that asks the user to confirm that the indicated moves should take place.

17. Inquire On Quote - Specifies whether to pop up a dialog that asks the user to confirm that the indicated commands should be sent.

18. Left Auto Local Login - specifies whether to automatically connect the left side to the local (client) host upon starting XFTP.

19. Max FTP Retries - Specifies the maximum number of retries XFTP will attempt if it receives a response from a FTP server that indicates the desired operation failed because of some temporary condition on the remote host.

20. Max Time for FTP Reply - Specifies the maximum time, in seconds, the XFTP waits for a response from a FTP server before concluding that the connection has been broken.

21. Preserve Vms Ver Nums - Specifies whether to preserve VMS (Virtual Memory System) file version numbers when transferring files from a VMS system. This is only an issue for those VMS FTP servers that provide numbers (not all do).

22. Print Password In Debug - Specifies whether to print passwords in the log window when the user preference Diagnostics is set to Debug.

23. Quote Cache Size - Is the number of quoted commands to cache. The cache is preserved across XFTP sessions.
24. Quote Placeholder - Is used as a placeholder in a quoted command to represent items selected in the directory list.

25. The quoted command “stage 1 <>” sends a STAGE command to the remote host for each selected item.

26. Recursive Delete Enabled - Specifies whether to enable the Recursively Delete Selected Entry(s) item in the Ops menus. Choose No to help prevent accidental recursive deletions.

27. Right Auto Local Login - specifies whether to automatically connect the right side to the local (Client) host upon starting XFTP.

28. Sort Caches - Specifies whether to sort (by ASCII-collating sequence) cached items when they are displayed in dialogs. If Yes, then sort. If No, then the most recently referenced items are placed at the top of the list.

29. Sort Long Lists By Date - Specifies whether to attempt to sort the long directory lists by time modified (with most recent listed first) instead of by name. The Yes option is considered unsafe because some FTP servers do not support this option and may give unpredictable results (Most UNIX hosts support this option).

30. Store Unique - Specifies whether existing sink files are to be renamed before file transfer occurs. If Yes, then the existing sink file is typically renamed by appending a “.” (period) followed by an integer between 1 and 99.

31. Symbols On Dir Entries - Specifies whether to append single characters to directory entries in order to distinguish their types.

(1) The Yes option is considered to be unsafe because some FTP servers do not support this feature and may give unpredictable results (Most UNIX hosts support this option).

a. If Yes (Unsafe) is chosen, “/” is appended to directories.
   b. “*” is appended to executables.
   c. “@” is appended to symbolic links.
   d. “.” is appended to AF_UNIX address family sockets.

(2) If you are referencing a directory or directory entry whose name ends with one of the special characters, you need to select No (Safe) or when in doubt, select No (Safe).

32. Use Last Dir At Login - Specifies whether to automatically enter the most recently referenced directory after connecting to a host. If this option is requested, but is
not possible to perform (e.g., because the directory no longer exists), an error message is generated, and your home directory is entered.

33. User Cache Size - Is the number of user names to cache (for remote hosts). The cache is preserved across XFTP sessions.
34. Wildcard Cache Size - Is the number of wild card expressions to cache. The cache is preserved across XFTP sessions.

2.8 Send File

The JDISS Send File function allows the user to send and receive files from another JDISS workstation using a point and click window tool. The distant user must except the file before it is transferred. This control of file transfer ensures that files too large for the receiving station can be rejected and that the receiving station knows that the file is now available locally in his directory.

2.8.1 Activate Send File

1. To access Send File, double click on the Send File icon in the Communications Desktop window. The below Send File window will appear.

![Figure 2-47 (Send File)](image-url)

2. To send a file, select the directory from which to transfer files. It will be displayed in the SELECTION window.
3. Click on the file to be sent from the Files window. The file will be added to the directory in the SELECTION window.

4. Enter any descriptive information about the file you want the remote user to see within the TEXT MESSAGE window. Press the SEND FILE button. The window below will be displayed to ask for the File Type. If you do not know the file type, select OTHER.

![File Type](image)

Figure 2-47 (File Type)

5. Click on the Accept button. The File Type window closes and the File Information window appears.

![File Information](image)

Figure 2-48 (File Information)

6. The File Information window is a dialog displaying the previous selections. Click Yes if all entries are okay. The File Information window closes and the rConnect pop-up window appears.
7. Click on the hostname to send the file to, then click on OK. The rConnect pop-up window closes. If the receiving JDISS machine accepts your request and there are no problems with their system, you will see the FILE TRANSFER COMPLETE window appear on your screen. Click OK.

8. The user can send another file to this host or disconnect and send to a different host at this time. To disconnect, select the File pull-down menu and select Disconnect from Remote Host.

2.8.2 Acknowledge Receipt

1. When a user is sent a file, he will first receive the Accept Send File window indicating a file is waiting to be transfer. Click Yes to acknowledge to the sender that receipt of the file is acceptable.

2. The Receive File dialog window opens and enables you, as the receiving site, to control the number and size of files on your system. If your system cannot handle the size of the file, then you would now click No.
3. On the Select File window select where the file is to be saved, then click OK. The Select Directory window will open. Select a path name from the Directories listing on the left side of the window. Click on the filename to select the file, then click on OK to receive the file into the selection. Once the file is transferred, the sending system receives a notification that the file was received.

4. Once the file is successfully received, the File Transfer Complete window appears. Click OK to close the File Transfer Complete window.
2.8.3 Close Send File

To close the Send File window, click on the File pull-down menu and select Quit. The Send File window closes.

2.9 XMIT

The purpose of XMIT is to allow users with different levels of computer expertise and system authority to use and configure the tactical communications (TACO2) protocol. By using a sign-on mechanism, XMIT only shows the user the functionality permitted by his privilege level which is previously assigned as either a normal or privileged user (XMIT is normally for only the experienced user).

2.9.1 Applications XMIT Supports

1. XMIT distinguishes between Normal and Privileged users by providing a sign-on mechanism that will allow it to group the users into two classes.

   (1) Normal users (Operators) will be restricted to using the application to send and receive files, ping other sites, do a bit error rate test (BERT), and pull files.

   (2) Privileged users (Administrators) may also use the application to configure both TACO2 and additional users.

     The application will only show the user the functionality permitted by his privilege level.

2. The Send File is one of XMIT's primary functions. It allows the user to select a group of files and queue them for transmission to a remote site.

3. The other primary function is Receive File. It allows the user to place the system in a standby mode such that it can receive files from any site in addition to attended receivables.

4. Ping sites allows all users to ping an existing site to determine if that site is active. This will be used to determine if the user can send files to the other site.
5. Configure TACO2 allows the user to configure the underlying TACO2 software. This is XMIT’s secondary function. All TACO2 configuration options will be available from within XMIT.

6. XMIT allows multiple concurrent sessions of TACO2 to run. This enables a user to manage many tasks, like sending and receiving at the same time.

7. XMIT will present a layered view of both the communications and configuration processes. This approach allows users at different levels of expertise or system privileges to access the underlying TACO2 software.

8. UNIX Runtime Environment executes a UNIX operating system within XMIT.

9. XMIT will make use of the X Windows and Motif layers to present it’s user interface.

10. The visual appearance of XMIT will follow the Motif and DoDIIS style guides. Where these style guides differ, DoDIIS has preference.

2.9.2 XMIT Application Interfaces

There are three XMIT Application Interfaces.

1. The User Interface is designed with the user in mind. The user is able to configure as much or as little of the TACO2 system that is required based upon his expertise.

2. In order for the information selected by the user to Interface to TACO2, the following actions must occur.

   (1) A Parameter File is created from the information selected by the user through the user interface. This file has fields as defined by the TACO2 program. These fields are filled in with the information selected by the user. Any field in which the user did not specify a value will be set to a default value as determined by the TACO2 program (thus allowing users with different degrees of expertise to use the application).

   (2) The TACO2 Daemon Invocation sets up the mechanism to link the port/address to your process as communication can occur.

   (3) The TACO2 Invocation is the program that is invoked with a set of switches and input files, just like someone would invoke in any program under the UNIX environment. One of the input switches would include the parameter file just created according to the user’s specifications.

A2-40
3. System Interface is the interaction between the program and the underlying UNIX operating system. The XMIT application consists of a sub-program called “xmitl”. The xmitl program provides a login mechanism. If the user enters a valid user id and password, the xmitl program will automatically invoke the XMIT program.

2.10 Conclusion

Communications is the means by which the user pulls documents, pushes documents (files and directories), talks to other JDISS users using Chatter (text), Jvox (secure voice) or Alert (short text messages) and checks communication connectivity. In short, Communications allows real time or near-real time problem solving, analysis and dissemination of critical data and not so critical data depending on the need. The JDISS Communications Application connects the user to the outside world.
APPENDIX A
SECTION 3
JDISS IMAGES APPLICATION

Images provides the capability to accept and gather various imagery formats for display and manipulation through the use of five basic applications. The power of the Images application rest in the Electronic Light Table (ELT). ELT provides users the ability to manipulate a finished imagery product for local use or for dissemination. Manipulations include extracting sub-images, applying overlays and annotations and improving the images through a variety of spatial transformations and imaging processing. Another special Images strength is the two optional intelligence tools which are used for mapping applications. Imagine is a JDISS package that analyzes or creates graphical models while Digital Camera inputs still photographic images into JDISS for analysis. Additionally, Images includes the Joint Universal Imagery Client (JUIC) a Mosaic document viewer which provides access to multiple imagery sources and a High Performance Peripheral and Imaging (Hippi) enabler which provides an interface to ScanShop for scanning images into the system in various resolutions for manipulation.

Figure 3-1 (Images Icon)

To access the Images Desktop window from the JDISS User Main Desktop, double click on the Images icon. ELT and Hippi applications will be addressed in step-by-step detail. Imagine and Digital Camera are special intelligence applications and beyond the scope of the new user and this Guide. JUIC is an icon selection for the Mosaic program and requires no amplification for use.

Figure 3-2 (Images Desktop Icons)
3.1  ELT

JDISS uses Paragon's Imaging Electronic Light Table to view and manipulate images. With ELT you can sharpen, blur, transpose, rotate, invert, etc., an image or selected regions of interest, apply overlays and annotations, and extract sub-images. Images can be saved in several available formats (see paragraph 3.1.2 - JDISS Imagery Formats) for use with other image processing packages.

3.1.1  Activate ELT

To access ELT, double click on the ELT icon in the Images Desktop window. The ELT image processor will appear and disappear automatically. The Basic ELT window, shown below, will appear which has limited functions until an image is loaded.

![ELT/2000 Window Diagram]

Figure 3-3 (ELT/2000)
1. The ELT window is divided into the following four main areas. The Menu Bar will be addressed within this section. The other three areas are covered in section 3.1.3, Imagery Manipulation in ELT.

   (1) Menu Bar - This contains a list of pull down menus divided into functional categories.
   (2) Tool Bar - The tool bar contains commonly used functions. The tool bar can be customized to hold icons for the functions the user most often uses.
   (3) Image Area - This is where images (including any overlay graphics) are shown. If an image is larger than the space available, the scroll bars at the bottom and right sides of this area can be used to see the hidden sections. The user can also stretch the entire ELT window to see more of the image.
   (4) Message Area - Displays the size of the image, the cursor position and pixel read out, as well as other relevant information.

2. The Menu Bar has eight pull-down menus. Many of these have common functionality which the new user will recognize by name. Others are special applications which are worth user experimentation. However, these applications have default settings that will satisfy most new user needs.

   (1) File
      a. New - Used when scanning in an image. Initially, a blank white screen will appear waiting for new image to be scanned (Image file name located within the banner will change and all ELT functions are now active).
      b. Load - Used to load an image from a file to the display. This function also loads the image into the gallery, discussed later.
      c. Unload - Used to unload an image. Will not delete the image if previously saved to the gallery and is a good option if a mistake is made.
      d. Save As - Provides several format options for saving images (See section 3.1.2, Imagery Formats).
      e. Delete File - Select from File list or type the file name and then click on Delete file.
      f. Restore - Restores image from previously saved image. This allows user to recover from mistakes and allows the user to try different options while manipulating the image without fear of destroying the original image.
      g. Image Print - Prints the image.
      h. Image Scan - Inputs scanned image from scanner which is selected from the pop-up scanner list.
      i. Image Video - Optional (A special capability that requires a proper frame grabber and driver to be installed).
      j. Screen Capture - Captures or crops a smaller portion of the displayed image as a separate image. Screen will change to new captured image portion
and will list new image as an image in the user’s gallery (discussed later). Cursor arrow will change to a double plus sign.

k. Export - The Help file states, “Provides peer application list” (Have found no requirement for this function—does not do what the user expects the function by name to do).

l. Invoke - The Help file states, “Provides peer application list” (same as Export).

m. Communications - May be used to send or receive imagery files between another ELT application located on another JDISS workstation. User must have the hostname in which to send a file and the medium that is going to receive the file in order to select the correct format and compression rate. User can send current viewing image or send from the list of files. Also, as a sub-function Remote Control allows two users on different terminals to work together on one specific image on ELT.

n. Quit ELT - Terminates the session.

(2) Edit

a. Select All - makes everything in the document area active.

b. DeSelect All - opposite of Select All

c. Other Selection - Will Give you a sub-menu. This makes selection of items possible when they are stacked or difficult to select with the mouse pointer.

1. Text Strings - This will activate all text strings on the current image. Text is active when it is outlined with small white squares. The text selected by this method can be moved or deleted as a group (Other options — Lines, Rectangles, Ovals, Polylines, Images, Bitmap symbols - Same as Text Strings).

2. Individual Symbols, text, images, etc., can also be selected by clicking on them with the mouse cursor. Multiple selections can be made by holding the shift key down as the user clicks on each additional selection. This allows you to select several different objects when All is not desired.

d. Delete - Removes any active selection(s). An item is active when surrounded by small white squares.

e. Cut - Removes active selection and stores the last items cut (Stores over any previously stored cut or copied item).

f. Copy - Copies active selection and stores last items copied (Copies over any previously stored copied or cut item).

g. Paste - Adds last items cut or copied to image.

h. Bring to Front - Moves the active item(s) forward on the image to include all other annotations currently on the image.

i. Send to Back - Moves item(s) backward on the image.

j. Alignment - Aligns all active items per selection from the sub-menu, i.e., vertical, horizontal, center, etc.

A3-4
k. Group - Groups all active selections.
l. Ungroup - Ungroups the active group.
m. Attachment - Provides sub-menu of Attach, Detach, Detach From, Detach All. These are similar to Group and Ungroup. By selecting annotations and the image, the user can attach the annotation to the image so that whenever the user again selects the image all attached items are active too. However, attachment, unlike group, still allows the user to individually select the annotations without selecting the group and having to ungroup to edit. Attachment works well while the image is still being manipulated. Group is better for final product and dissemination.

(3) View

a. View - Allows the user to either individually view or hide images, texts, lines, annotations, etc., or view and hide all by clicking appropriate selection.

(4) Enhance

a. Library Menu - provides several automatic transformations and image processing to image. A detailed description of each one is not required or needed for common users. Clicking on each will show you different enhancements, most unusable except for specific purposes. Remember the File/Restore function to return to the original image after each tried selection until you find the best transformation and/or processing feature for your use.

b. Crop - Bad command — Should perform as a “crop” command and cut portion from an image.

c. Enhance - Provides sub-menu of on-screen selectable percent’s for changing scale of image.

d. Convert to - Provides sub-menu of on-screen conversions to 1 Bit Bi-level, 8 Bit Grayscale (normal), or 24 Bit RGB Color.

e. Color-map Editor - Starts ELT Color-map Editor. For black & white photos, editor will be varying levels of grayscale. For color photos, color options are provided. Allows preview of changes before applying them to the image.

f. Clip Gray Levels - Must have grayscale image to use (may convert using “Convert to” selection above).

  g. Brightness / Contrasts - Provides sub-menu that allows manual adjustment of brightness and contrast.

h. Image Processing - Provides the same imaging processing found in the Library Menu. Used as a short cut selection.

  i. Edge Detection - same as Image Processing.

  j. Flip / Rotate - same as Image Processing.

(5) Tools
a. Copy document - Will provide additional copy in the gallery (Gallery found under Window menu).

b. NITF Header - Provides pull-down menu to add header information to the image for future or transmitting requirements.

c. Text Notes - Provides text window where the user can make notes about the image. Notes can be saved as separate file or attached to the image. Text Notes can also be selected by clicking right mouse button on the image (Press Dismiss to hide the notes. Delete will permanently remove typed notes).

d. Image Info - Provides Read-Only information about image. This information includes image display level, size, data type, data size and security classification.

e. Gallery - Provides miniature images of all images loaded into the Gallery. Selection can be made of image to be displayed by clicking on the image with left mouse button. All images loaded into ELT during the current user’s session are held in the Gallery until the user quits ELT. This allows multiple images to be worked at the same time easily moving back and forth between images. Gallery is also used when using the Movie Loop function.

f. Pan Viewer - Provides miniature image of current image in main window. This is particularly useful when the image is too large for the main display window.

g. Movie Loop - Provides ELT movie loop control and movie loop display. This provides a slide show of images selected from the Gallery in any order desired. Number of times repeated and time each image is to be displayed is selectable.

h. Preference - Provides sub-menu of following functions:

1. Colormap - Provides on/off selection of several colormap preferences.

2. Zoom - Provides zoom methods of replication or interpolation (replication is preference of choice).

3. Tool Bar - Provides modification of Tool Bar per user’s choice.

(6) Macro

a. New - Opens sub-menu for ELT Learn Macro’s.

b. Load Macro - Loads macro from selectable directory.

c. Manage - Opens sub-menu for managing and editing ELT macro’s.

d. Command - Provides message window for command input.

(7) Window

a. Refresh - Refreshes Image area.
b. Compact Workspace - Moves image to left-upper corner of Image area.
c. Enlarge Workspace - Centers image in Image area with maximum working white space.
d. List - Lists all images loaded in the Gallery. Click on any image to load it into Image work area.

(8) Help

3.1.2 JDISS Imagery Formats

1. Paragon Imaging Data Format (PIDF) - ELT 2000 standard image format which is quick to load and quick to save and excellent for file transfer protocol (FTP) and E-Mail between JDISS terminals. This format is used to view the image in ELT-2000 and is automatically executed when importing an imagery file from other various mediums. However, you cannot transfer or send the image to other Secondary Imagery Dissemination Systems (SIDS) in this format.

2. National Imagery Transmission Format (NITF) - SIDS image format that is associated with Demand Driven Direct Digital Dissemination (5D). NITF is the universal format and viewed by ninety percent of all imagery tools. There are two different NITF formats (1.1 and 2.0), 1.1, unlike 2.0, cannot transfer color graphics. This format is necessary for transferring to another SIDS device. It is a good idea to create a directory for NITF images such as: /opt/5D/5D_files/NITF, after you have manipulated the image in ELT.

3. Tagged Imagery File Format (TIFF) - Allows the transfer from UNIX based applications to IBM DOS based applications. A disadvantage is TIFF is larger to save than NITF and takes longer to load.

4. Grabbed Image Format (GIF) - Allows the transfer from UNIX based applications to IBM DOS based applications. It also is large to save and takes longer to load.

5. The below Figure 3-4, Formats Relative File Size, shows a comparison of the approximate file size of various formats based on an image data size of approximately 700,000 bytes. The JDISS imagery formats are listed across the bottom of the legend.
3.1.3 Image Manipulation in ELT

To load an image, select Load from the File pull-down menu, shown below, and double click on the image file desired. Express loading and start of ELT is also possible by clicking on the Image icon in the Shared or Home directory. When the image appears in the document area, all functions of ELT are now accessible.

Figure 3-4 (ELT Load)
1. Locating previously loaded images is possible in any of the following methods.

(1) Click on Windows and the list of imagery file names will appear at the bottom of the menu pull-down file.
(2) Click on filename to view image.
(3) Click on Tools and select Gallery from the pull-down menu or click on express icon on the tool bar. The ELT Gallery window will appear. Displayed will be a miniature view of all loaded images. Click on specific image to view.

Figure 3-5 (ELT - Gallery)

a. For example, click on ship.pidf for viewing.
2. To zoom in or enlarge an image follow the following steps:

1. Click on the Express Line icon that has the number percentage and select a specific zoom percentage.

2. Click on Tools and select Preferences menu, then click on Zoom from the cascade menu from the pull-down.

(3) The Zoom preferences are replication (default) and interpolation. 
   a. Replication means duplication of pixels, making it grainier.
b. Interpolation attempts to make a best guess at what the pixel values should be between actual pixels in the image.

![Figure 3-8 (50% and Interpolation Selected)](image)

3. To Pan an Image follow the following steps.

(1) Click on Tools and select Pan Viewer from the pull-down menu or click on Express Line icon. The ELT - Pan window will appear.

![Figure 3-9 (ELT - Pan)](image)

(2) Click on specific area inside pan window and the image in the display area is automatically updated.

(3) Outline box in pan window tells you what portion of the image is being displayed in ELT Image area. For example, Select Zoom 200% and watch the red outline in Pan window change accordingly to show you how much of the Image is being
displayed. This feature is good to let you know how much of the image is hidden or what portion of the image you are focused. Actual image size can be seen by clicking Image Information under Tools menu.

4. To Capture an Image follow the following steps.

   (1) Click on File and select Screen capture from the pull-down menu.
   (2) The cursor will change to a double plus sign. Starting at the upper left corner of the area you want to define, click and drag diagonally to the opposite corner. Release and the new image will appear. As shown below, the three helicopters were captured from the deck of the ship.

   ![Screen Capture Image](image)

   **Figure 3-10 (Screen Capture Image)**

5. Copy and Paste Captured Image can be accomplished by the following steps.

   (1) Ensure captured image is displayed.
   (2) Click inside image to make active (small white squares in corner show image active).
   (3) Click on Edit, select Copy from the pull-down menu and when the white squares in the corner disappear, the copy is complete.
   (4) Redisplay image you desire to ‘paste to’ from the Image Gallery or Window pull-down.
   (5) Click on Edit and select Paste, the captured image will appear.
   (6) The captured image is active and can be placed anywhere by clicking inside the captured image and dragging it to a specific area. As shown below, the captured image of the helicopters has been added back onto the original ship image.
6. Image Enhancement is possible with the following steps.

(1) Click on Enhance and select Library menu from the pull-down menu. The ELT - Library window below will appear. Remember, as each button is tried, the original image can be restored by following the steps found in the Restore Image section. Most of these buttons will only show an improvement when using the original image. In other words, the image will normally become more and more unrecognizable if several enhancement buttons are selected, one after another.
(2) Click on the Stretch / Contrast button. The contrast within the image will change and the following image will result.

![Figure 3-13 (Stretch / Contrast)](image)

(3) Click on Equal / Contrast button using the original restored image and the following image will result.

![Figure 3-14 (Equal / Contrast)](image)

(3) Click on the Sharpen button using the original restored image and the following image will result.
(4) Click on the Invert (White to Black) using the original restored image and the following image will result.

(6) Click on Enhance and select Brightness/Contrast from the pull-down menu or click on the express icon. The ELT - Adjust Levels window will appear, as shown below.
Figure 3-17 (ELT - Adjusts Levels)

a. Click and drag buttons to desired Brightness and Contrast (results will be immediately observed). Click on Apply to set the image.

7. To Restore an Image follow the following steps.

(1) If image becomes unidentifiable due to various image enhancements, click on File, select Restore from the pull-down menu. The ELT - Restore window will appear.

Figure 3-18 (ELT - Restore Image)

(2) Click on OK and the image will be restored to the last time it was saved.

8. To Annotate an Image the following steps should be followed.

(1) Draw Palette.

a. From the Express Line click on the Draw Palette. Directly underneath (i.e., the second line of icons) will be a display of available drawing tools.

Figure 3-19 (Available Drawing Tools)
b. The drawing tools are affected by the currently selected line thickness and color. Make sure these are set before drawing. Choose the thickness and color you wish to use by clicking once on Line Style and selecting your choice from the available list. Click on Color outline and choose from the available list.

c. Choose the tool which you desire to annotate with (line, oval, circle or box) by clicking once and moving the cursor to the area on the image you wish to annotate. Click and drag the mouse until the area you wish to be highlighted is defined and release the mouse button. For example, as seen on the image below. A blue box was selected using a solid line to highlight the Captured Image. A blue arrow was then drawn to show the area the Captured Image was taken from. A Red Circle using a dashed line was drawn around a dome on the starboard side of the ship.

![Image](image.png)

**Figure 3-20 (Drawing Tool Annotations)**

d. To move a drawing tool annotation once it has been drawn, click once on the Arrow icon and click cursor on 0, 90, 180 or 270 degrees of the annotation item you desire to move.

e. Drawn tool item will be active when it is outlined with small white squares. Clicking on the white squares and dragging the mouse will re-size the tool. Clicking on the outer edge of the outline and dragging the mouse will reposition the tool item on the image.

f. The tool items can also be made active by choosing Other Selection under Edit menu and clicking on Type (line, oval, circle, or box) of the item you want activated. However, this method will activate all items of that type within the image.

(2) Text Palette

a. From the Express Line, click on the Text Palette and directly underneath (i.e., the second line of icons) will be a display of available text tools (font, size and color).
Figure 3-21 (Available Text Tools)

b. Select desired Font type, Font size, and color by clicking once on each icon and selecting your choice from the available list.

c. Click once on the Insert text express icon, the cursor will change from an arrow to a “double capital ‘I’ ”, called a compass cursor.

d. Move cursor to the display tool you have on the image, click once where you want the text to appear. Text cursor will appear directly above the compass cursor and will flash on and off. Type in desired text, then hit “escape” key to anchor it. As shown below, a title and names for highlighted areas have been added to the image in yellow.

Figure 3-22 (Text Tool Annotations)

e. To move or delete text once it has been entered, click once on Arrow icon and click cursor on any part of text. The text will be active when it is outlined with small white squares. Clicking on any part of the text and dragging the mouse will reposition the text on the image. Pressing “Delete” while text is active will delete it.

(3) Region of Interest (ROI).

a. From the Express Line click once on the ROI icon, directly underneath will be a new display on available ROI tools (pencil, polygon, or box).
Figure 3-23 (Available ROI Tools)

b. Select desired shape, click and drag mouse over the image area, release and a ROI pink outline is added to image.

c. Click on Show Information. A Histogram and Statistics will be shown of the ROI selected.

d. Once the ROI is drawn, process it as a separate image by clicking on Convert ROI to Image. The Image will be outlined. Click inside the outline and drag ROI to any specific area of the image. As shown below, several items on the ship’s bow where chosen as a ROI, processed and moved to the upper corner of the picture.

Figure 3-24 (Ship with ROI Image)

3.1.4 Saving and Converting Images

1. Select Save As from the File pull-down menu. The ELT Save window will appear.
2. Select the /home/machine_name/login_name/Images directory.

3. Enter the image name in the file-name field or choose the image's original name to replace the image.

4. Click on Format button, click on desired format (see available formats earlier in this chapter for best format).

5. Click on Save button to write a copy of the image to disk.

6. If you selected NITF, you will get an ELT-NITF Options window, shown below.
7. Click on appropriate selections and click OK. Image file now has been saved to the user's directory.

3.1.5 Print an Image.

1. Click on File and select imagePRINT from the pull-down menu. The ELT Printer List appears. Click on the specific printer desired and then click OK.

2. The ELT Printer Setup window automatically appears. Click on appropriate parameters and click on OK. The ELT Printer Setup Window will appear as shown below.
3. Click OK. The image will be sent to the selected printer and printed.

3.1.6 Conclusion

The Imagery applications in JDISS provides users with the ability to manipulate finished imagery products, format imagery for re-dissemination, and printing of imagery from various mediums. Tailoring the finished products to meet the specific needs of your forces / units meets two critical requirements: Up-to-date imagery of the battlefield and expeditious dissemination of intelligence information.

3.2 Hippi

Hippi is a High Performance Peripheral and Imaging Enabler (HiPPIE) which provides an interface to ScanShop enabling an images to be scanned into the system in various resolutions, manipulated and saved and/or printed. Hippi also provides a SCSI and GPIB printer interface.

3.2.1 Scanning an Image

1. To access Hippi, double click on the Hippi icon in the Images Desktop window. The ScanShop window opens as seen below.
2. Click on the Scan pull-down menu and select Setup to open the below Scanner Setup window.

3. After setting parameters (Parameters are similar to any other program), click on Preview and ScanShop will start a preview scan of the image.

4. The Preview image will appear in the Preview Area as shown in Figure 3-30. The user can now select that portion of the image desired. At a minimum, the user should crop the smallest portion of the image (close as possible) to minimize the white space, thus reducing the byte size of the final image. Additionally, adjust both the brightness and threshold controls for the best image. For this example, only the “Apache” image is cropped. The selected area is outlined by eight small squares.

5. After previewing, click on Scan. A final scan will now be initiated and the scanned image selected will automatically be transferred to the ScanShop Window below.
3.2.2 Saving an Image

1. Click on the File pull-down menu and select Save As. The Save Image window below opens.

2. Select the directory path where the file is to be saved from the left side of the window. Click on the Format pull-down menu to select a file format. Enter the file name in the selection box near the bottom of the window. Click OK.
3.2.3 Printing an Image

1. Click on the Print pull-down menu and select Print. Image file is automatically sent to the default printer.

2. If the user desires to select a different printer or change a print parameter, click on the Print pull-down menu and select Setup. The Setup window below opens.

![ScanShop (TM) Print Controls](image)

Figure 3-33 (ScanShop (TM) Print Controls)

3. Set the specific parameters desired. The type printer is selected from a printer pull-down menu located in the top right corner. The other few choices are optional and easy to understand and select.

3.2.4 Conclusion

The pull-down windows are not addressed individually because the user will find standard features that are obvious as to function and use. ScanShop offers limited capability to manipulate but the user will find the rotate and view options helpful if the only purpose is to scan and print. However, if the image is to be saved following the scan for either local use or dissemination, the user can load the saved image into ELT for final processing and manipulation.
APPENDIX A
SECTION 4
JDISS UTILITIES APPLICATION

The purpose of Utilities is to provide the user with convenient tools in a single window. There are eighteen utility functions available on the standard JDISS workstation. Several of the Utilities are single function which are obvious by the Utility name. Others are versatile and require more detail to gain an understanding of their full benefit to the user. The following icon is used to access the JDISS Utilities applications.

![Utilities Icon](image1)

Figure 4-1 (Utilities Icon)

To access the Utilities Desktop window from the JDISS User Main Desktop, double click on the Utilities icon. The Utilities Desktop window appears with the eighteen icons for the sub-programs. These programs will be discussed in the icon order shown.

![Utilities Desktop](image2)

Figure 4-2 (Utilities Desktop)
4.1 Backup-Restore

Backup-Restore provides a means to backup and restore both personal and shared directories from hard-drives to a magnetic media as selected by the user.

4.1.1 Backup to Magnetic Media

1. Prior to accessing Backup-Restore, insert a floppy disk or 8mm tape into its appropriate drive and wait until the floppy disk or tape has been read (approximately 30 seconds), then double click on the Backup-Restore icon in the Utilities Desktop and the Storage and Retrieval window appears.

![Storage & Retrieval Window]

Figure 4-3 (Storage & Retrieval)

2. Under the Hard Disk heading, click on the Quick Change Listing. On the left side of the Storage and Retrieval window, click and select the desired directory or scroll through the directory contents and select the desired file to be backed up.

3. Under the Tape heading appears a list of devices that the system may use for storage. Click on the appropriate button to select the desired storage device.

4. Click on Backup in the center of the screen and a window will pop-up telling the user the Tar (Tape Archive) tape is being created. At this point, the user can also cancel the backup by clicking on Cancel.
5. When the backup process is done, the user will be alerted by a window. A copy of the selected file(s) will have been placed on the magnetic media that was chosen by the user.

6. To verify the file has been backed up on the appropriate selected media, click on File and select Restore Interface. Click on the center button that says Read Tape.

7. The contents of the floppy disk/tape will appear in the window under the Hard Disk heading.

4.1.2 Restore from Magnetic Media to Hard Disk

1. To restore files from (or view the contents of) a floppy disk or 8mm tape, select Restore Interface from the file pull-down menu.

2. Click on the center button that says Read Tape.

3. The contents of the floppy disk/tape will appear in the window under the Hard Disk heading.

4. Select file(s), click the Restore button to begin a Restore. The window below appears.
5. Enter the desired directory path, click OK, and the following window appears.

6. The selected files will be restored to the previously chosen file path. Clicking the Cancel button will stop and cancel the Restore.

4.1.3 Backup and Restore Characteristics

1. Tar (Tape Archive) - This command allows the user to write files to and from different file systems, to floppy disk or tape.

2. Dump - This command allows the entire file systems to be written to tape. It also lets the user manage the information being sent to the tape by doing incremental dumps.

3. Absolute Path - The user must include the full name of the file including the entire directory path. Always begins with a “/” (the UNIX root directory symbol), and may not contain special directory names. For example, the absolute path name for a file might be, /Home/Europe/England/Cambridge.doc.

4. Relative Path – Assuming the user’s current location is within a file’s directory, then it is the actual name of the file within a directory i.e., the name that follows the last slash in the absolute path. Using the previous example, the name would be, Cambridge.doc. The relative path is like the absolute path except the user’s current location is the relative pathname starting location while an absolute pathname always starts at the UNIX top level or root level symbol “/.”
4.1.4 Close Backup and Restore

1. To Close, select File and Close and the Storage and Retrieval window closes.

4.2 Calculator

Utilities provides a pop-up scientific calculator for user's convenience. To display the calculator, double click on the Calculator icon and the calculator window below appears.

![Calculator Image]

Figure 4-8 (Calculator)

4.3 Calendar

The Calendar provides the user with a month, a day-at-a-time and event, and an address book capability.

4.3.1 Open Calendar

1. Double click on the Calendar icon and the synchronize calendar below appears.
2. Double click on a day and the Day-at-a-Time window appears allowing the user to establish appointments and set alarms.

3. To create an event for the calendar, click on Create Event. Ensure the correct day is highlighted in left hand window and click and drag on the desired time for the event.

4. Type in Event Title in the center line window and click on Add to enter the title.

5. Click on View and select Calendar View and event title will appear on the appropriate day.
6. On Day-at-a-Time window, click on file and select Open Address Book. An Address Book window will open (not shown) providing spaces for a Name, Company, Phone Number, Fax Number, Address, Email Address, and Notes.

4.3.2 Close Calendar

To close the Calendar window, move the cursor to the Calendar window’s System Menu button, click left to pop-up the System Menu, and click on the Close menu item.

4.4 Clipboard

Clipboard provides a temporary storage location for text-only material copied from applications like Applix Word or typed directly.

1. Double click on the Clipboard icon in the Utilities Desktop to open the below window.

![Figure 4-11 (Clipboard)](image)

2. Click and drag to highlight a block of text in a specific working document applications.

3. Move cursor into the Clipboard window and click the middle mouse button. The highlighted text will now appear in the Clipboard window for editing.

4. After editing, copy and move cursor to destination document i.e., text annotation on image, email, etc., and paste the text.

5. Simply click Quit to close the window.
4.5 Clock

The Clock allows the user to display the current time in Greenwich Mean Time (GMT) or "Zulu" Time Zone. The user can also select any area of the world and view their local time. Displays may be digital or analog format by selecting Edit and either Analog or Digital.

4.5.1 Open Clock

Double click on the Clock icon, and the current GMT will be displayed.

![Figure 4-10 (Clock)](image)

4.5.2 Set Alarm

1. To change to the alarm display, click the left mouse button inside the clock window and the alarm display will appear.

![Figure 4-11 (Clock - Alarm Time)](image)

3. To set the Alarm, click the middle mouse button on a specific digit and it will be outlined as seen above over the "1".

4. Change the digit by clicking the middle mouse button and the digits will advance to desired time — one hour per click.

5. The Alarm will be a series of beeps and will be heard when the alarm time is reached.
4.5.3 World Map/Time Zones

1. Click and hold down the right mouse button in the center of the clock and a pull-down menu appears. Select World Map and the Time Zones display below will appear.

![Figure 4-12 (Clock - World Map/Time Zone)](image)

2. Specific times of areas of interest can be accessed three different ways.

   (1) Click and drag the mouse in the Roam Box which is located in the upper left hand corner. The Area it outlines will be seen as the large display and the Area time will be displayed.

   (2) Position the cursor on a square icon and the name of the specific area will appear and then click. An analog clock will appear with the local GMT alongside the user’s GMT for his specific area. Click on Edit and select Make all Clocks Analog. The window will be displayed in the following example following the selection of Anchorage.

![Figure 4-13 (Area of Interest Time)](image)

   (3) Click on the down arrow located on the bottom of the window and scroll to the desired area. The area time will be shown for each area as they are scrolled through.
4.5.4 Close Clock

Click on the file pull-down menu and select Close to close both the Clock window and the World Map window.

4.6 DOS Tools

DOS (Disk Operating System) Tools provides the ability to format, export, import, and delete from 3.5 inch floppy disks.

4.6.1 DOS Copy

1. Insert the floppy disk prior to running DOS Tools (it will look for the floppy disk upon start-up).

2. Double click on the DOS Tools icon and the DOS Utility window, similar to the Storage and Retrieval window, will be launched.

![Figure 4-14 (DOS Utility)](image)

3. The DOS Utilities window is broken into two parts. The Hard Disk to the right and the Floppy to the left. The left window, under each heading, gives a list of directories. The right window, under each heading, gives the lists of files within the directories.

4. The center buttons allow for the copying of files to either window. The buttons (>>Copy>>) and <<Copy<<) allow for the copying of one file in either direction (shown...
by the double arrows) to either the Hard Disk or the Floppy Disk. The buttons
(>>RCopy>>) and <<RCopy<<) allow for the copying of entire directories to either the
Hard Disk or the Floppy Disk.

5. At the bottom of the window is a status display window which shows what
function the user is executing.

6. Click on the Floppy pull-down and select Re-Read Floppy to see if the copied
file(s) exist on the floppy disk.

4.6.2 DOS Format

1. Under the heading Floppy, click and drag to Format Floppy to begin
formatting.

2. Format confirmation window below will appear, click Yes.

3. The format status appears in the lower portion of the DOS Utility window
stating, “Formatting Drive A.”

4. When the status disappears, formatting has been completed.

4.6.3 DOS Export

1. Under the heading Hard Disk, click on the Disk pull-down menu. Select the
directory where the exported file resides. Scroll through the file listing and double click
to select the file to be exported.

2. The center section of the window activates. Click on “>>Copy>>” to export to
the floppy disk.

3. While copying, a Copy Status window will appear, showing the status of the
execution. Additionally, the status window will alert you that DOS Tools is performing
the function.
4. When exporting to the floppy disk is finished, the exported file will appear in the right hand window under the Floppy heading.

4.6.4 DOS Import

The system allows the user to import data from IBM compatible personal computers via DOS formatted floppy disks to selected directories.

1. Under the heading Hard Disk, click on the Disk pull-down menu and select the directory where the imported file will be placed.

2. From the right side of the window, a listing of the contents of the floppy disk appears in the right column under the Floppy heading. Double click the file name to highlight the file to be imported.

3. The center section of the window activates. Click on “<<Copy<<” to import.

4. While copying, a Copy status window will appear, showing the status of the execution. Additionally, the status window will alert the user that DOS Tools is performing the function.

5. When importing to Hard Disk is finished, the imported file will appear in the right hand window under the Hard Disk heading.

4.6.5 DOS Rename

1. To rename the exported file, click on the specific file you wish to rename.

2. Click on Floppy pull-down and select Re-Name Selected. The Re-Name Item window below will appear.
3. Enter a new file name and click OK.

4. The new file name will appear in the right hand window under the Floppy heading.

4.6.6 DOS Erase

1. Click on the specific file to be deleted in the right hand window under the Floppy heading.

2. Click on the Floppy pull-down menu and select Erase Selected.

3. Confirmation window appears, click on Yes, and deletion will commence.

4. When the file disappears from the right hand window under the Floppy heading, deletion has been executed.

4.6.7 Eject Floppy Disk

Click on the Floppy pull-down menu and select Eject. The floppy disk will eject after a short pause.

4.6.8 Close DOS Tools

Click on the File pull-down window and select close and the DOS Tools application will close.
4.7 Shutdown

1. Double click on the Shutdown icon and this immediately shuts down the system software down in a clean and safe manner.

2. Network connectivity terminates when the following is seen:
   ">b to boot, c to continue, n for new command"

4.8 Print Screen

Provides the ability to print a hard copy of the display to a local or remote printer.

1. Double click on the Print Screen icon and this will activate the function of capturing the user selected portion of the current screen.

2. The cursor will change shape to a "90° angle bracket," click and drag the cursor over the area to be sent to the printer.

3. When dragging the cursor, start in the upper left corner and drag diagonally to the opposite corner. While doing this you will see an outline of the specific area.

4. Releasing the left mouse button will automatically send the specified area snapshot to the local or remote printer.

5. The Print Utility window will appear in which to specify the printer output device desired.
4.9 Project Manager

The Project Manager is an optional JDISS package and not used by the new user.

4.10 System Load

System Load is a tool for monitoring CPU (Central Processing Unit) usage. Double click on the System Load icon and the system load window below will appear.

Figure 4-19 (System Load Graph)

4.11 Save Screen

Save Screen provides the ability to save an image from your current display to a file in the user’s home directory.

1. Double click on the Save Screen icon and the system will open the window below which will prompt the user to enter a file name.
2. Enter the file name with a .xwd ending, click on OK and the cursor will change to a 90° angle bracket.

3. When the angle cursor appears, click and hold the left mouse button and drag over the specific area to be saved. When dragging the cursor, the user will see an outline of the area to be saved.

4. Release the left mouse button and the user will hear a series of beeps telling him that the specific area has been saved.

5. A bitmap of the specific area will be saved in the file name the user chose in the user's home directory.

6. Access the home directory to verify the file was copied.

**4.12 CDROM**

This utility tool enables the user to access files via the compact disk drive.

1. Double click on the CDROM icon and the CDROM desktop window below will appear.

   ![CDROM Desktop](image)

   **Figure 2-21 (CDROM Desktop)**

2. Double click on the CDROM Mount icon and a dialog window indicates if the CDROM is mounted successfully.

A4-16
3. Files are accessed, saved, copied, etc., by using the menu pull-downs similar to any word processing program.

4. To remove the CDROM, double click on the CDROM Eject icon.

4.13 Time Zone Clock

The Time Zone Clock provides a graphic look that shows the areas of the world currently in daylight and darkness.

1. Double click on the Time Zone Clock icon and the below window will open.

![Image of Time Zone Clock]

Figure 4-22 (Sunclock)

2. To close window, click on upper left corner “small bar” and click close.

4.14 Video Pix

Video Pix is a hardware and software interface that accepts image inputs in a frame grab format in either PAL, NSTC, or S-video format signals. The input may be either black-and-white or color. Once the image is either loaded from file or frame grabbed (i.e. VCR player), the image may be saved to a specified directory in a variety of formats including “.tif.” In order to grab a video frame, the Video Pix hardware must be
installed. Video Pix is beyond the scope of the new user. Detailed instructions are provided in other operator guides.

4.15 **Soft Windows**

Soft Windows is an optional JDISS package that provides a windows interface for personal computers running DOS. This package will be introduced in more advanced user guides.

4.16 **Disk Status**

Disk Status details the amount of disk space used on the system.
1. Double click on the Disk Status icon and the Disk Usage interface window below will appear.

![Disk Stats Interface](image)

**Figure 4-23 (Disk Stats Interface)**

2. The window provides the user with a graphical illustration of the disk status plus an actual statistical estimate of how much of the disk is being used and how much is left. The Free, Critical and Used space is color coded to provide status at a glance.

3. To Close Disk Status, click on the upper left corner “small bar” and click Close.

A4-18
1. Double click on the Set Password icon and the User Password window below will open.

![User Password](image)

Figure 4-24 (User Password)

2. Enter the old password and click OK.

3. Enter the new password and click OK.

4. Enter the new password again to verify and the system will now update the user's password to the new password. The application will close automatically.

The Version icon displays the application versions currently loaded to the JDISS workstation. Select OK and the window will close.
4.19 Conclusion

Not all the functionality of each utility tool is addressed. However, the critical fundamental items for the new user were provided to guide him through the basic requirements needed to learn and operate a JDISS workstation. The Utilities applications in JDISS are an integral tool for the user. Especially useful are the maintenance, storage, transfer and backup of files. JDISS has streamlined these executions for the users who do not have UNIX backgrounds so that they too can perform these critical functions with ease.
APPENDIX B: JOINT DEPLOYABLE INTELLIGENCE SUPPORT SYSTEM (JDISS) WORKSTATIONS REQUIREMENTS AND PERIPHERALS

The purpose of Appendix B is to provide the user with an overview of the hardware requirements that may be used as a host for the JDISS Applications.
# APPENDIX B

## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>JDISS WORKSTATION REQUIREMENTS</td>
<td></td>
</tr>
<tr>
<td>1.1</td>
<td>Minimum Stand-Alone Requirements</td>
<td>B1-1</td>
</tr>
<tr>
<td>1.2</td>
<td>Minimum Client-Server Requirements</td>
<td>B1-2</td>
</tr>
<tr>
<td>2</td>
<td>WORKSTATIONS AND PERIPHERALS</td>
<td></td>
</tr>
<tr>
<td>2.1</td>
<td>Fixed Workstations</td>
<td>B2-1</td>
</tr>
<tr>
<td>2.2</td>
<td>Portable Workstations</td>
<td>B2-1</td>
</tr>
<tr>
<td>2.3</td>
<td>Printers</td>
<td>B2-1</td>
</tr>
<tr>
<td>2.4</td>
<td>Scanners</td>
<td>B2-2</td>
</tr>
<tr>
<td>2.5</td>
<td>Digital Camera</td>
<td>B2-2</td>
</tr>
</tbody>
</table>
APPENDIX B

SECTION 1

JDISS WORKSTATIONS REQUIREMENTS

JDISS version 2.0 can operate within the UNIX environment on a wide selection of workstations. The following are the minimum workstation requirements.

1.1 Minimum Stand-Alone Requirements

To load JDISS version 2.0 with full applications requires a high-performance UNIX-based workstation with the following minimum requirements:

1. Central Processing Unit

   (1) 40 MHz
   (2) 28.5 MIPS (Million Instructions per Second)
   (3) Micro SPARC II Processor
   (4) TurboGX 8-bit Accelerated Color Graphics Workstation
   (5) TurboGX 1 MB frame buffer
   (6) 16 MB RAM (32 MB for best performance)
   (7) 1.44 MB 3.5" Internal Floppy Drive
   (8) 3 S-Bus Slots
   (9) Dual Serial Ports
   (10) 8-bit Audio Internal Speaker

2. CD-ROM (optional)

3. Hard Drive (Without Corporate Services Application, i.e., other local programs)

   (1) 1.341 GB - With JDISS Embedded Support (JES - interactive help tutorial)
   (2) 1.201 GB - Without JES

4. Laser Postscript Compatible Printer

5. Scanner (optional)
1.2 Minimum Client-Server Requirements

The requirements for Client-Server are similar to minimum stand-alone requirements in section 1.1 with the following additional minimum requirement exceptions.

1. Hard Drive

   (1) Client
      a. 557 MB (No JES or Corporate Services Applications)
   (2) Server (Without Corporate Services)
      b. 1.341 GB - With JES
      c. 1.201 GB - Without JES

2. 4mm, 8mm or 1/4" Tape Drive (Server)
APPENDIX B
SECTIO 2
WORKSTATIONS AND PERIPHERALS

JDISS can currently operate within the UNIX environment on a wide selection of workstations and connect to a variety of peripherals. The list continues to grow each day. The following are associated equipment items common today.

2.1 Fixed Workstations

1. JDISS Single Processors and operating software require
   a. Sun SPARC station 2 (Solaris 1.1.2/1.1.1 Rev B)
   b. Sun SPARC station 5 Model 70 (Solaris 1.1.2/1.1.1 Rev B)

2. JDISS Multi Processor and operating software require
   a. Sun SPARC station 10 Model 30 (Solaris 1.1.2/1.1.1 Rev B)
   b. Sun SPARC station 20 Model 50 (Solaris 1.1.2/1.1.1 Rev B)

2.2 Portable Workstations

1. SAIT (Sun OS 4.1.3 w/JDISS v 1.01)
2. CODAR Explorer (recommended) (Solaris 1.1.2/1.1.1 Rev B)
3. RDI Powerlite (recommended) (Solaris 1.1.2/1.1.1 Rev B)

2.3 Printers

JDISS can print to any postscript level 2 compatible printer. ALL third party printers supporting postscript level 2 and using Sun parallel cable or Newsprint card can print from JDISS applications. It should be noted that the printing of images or graphics from applications could result in postscript files being created which may be up to four times the normal size. This encapsulation of the image into a postscript format not only consumes lots of memory but is also time consuming. This list is dated as of April 1996.

1. General Purpose Postscript
   a. LEXMARK Optra R Series High Resolution Laser Printer (1200 DPI @ 8ppm or 600 DPI @ 12ppm)
   b. Sun SPARC printer II (600 DPI @ 12ppm)
   c. Sun SPARC printer (300 DPI @ 12ppm)
   d. Sun Newsprinter 20
2. High Resolution Color Postscript
   a. Tektronix Phaser 540 Color Laser Printer (600 DPI @ 3.5ppm)
   b. Tektronix Phaser 440 Small Format Color Printer (300 DPI @ 2.5ppm)
   c. HP LaserJet 4 (600 DPI)

3. Medium Resolution Color Postscript
   a. Tektronix Phaser II SDX Mid-Resolution Color Printer (300 DPI @ 4.1ppm)
   b. Tektronix Phaser III PXi Color Printer (300 DPI)

4. High Resolution Imagery Printers
   a. XL7700-CS SCSI Interface Printer
   b. XL7720-CS SCSI Interface Printer
   c. XL7720-CI IEEE 488 Interface Printer
   d. XL8600
   e. Tektronix Phaser 480 Color Printer

5. Printers/Scanner/Copiers
   a. Canon CJ-10 Color Printer/Scanner/Copier (400 DPI)

2.4 Scanners

1. Microtek ScanMaker II XE Flatbed Scanner (600 x 600 DPI, 8.5" x 13.5")
2. Sharp JX-610 Flatbed Scanner (1200 x 1200 DPI, 11" x 17")

2.5 Digital Camera

1. DCS 200 Kodak Digital Camera with SCSI Interface
2. DCS 420 Kodak Digital Camera with SCSI and PCMCIA removable Hard Drive
3. DCS 460 and DCS 465 are “NOT SUPPORTED”
LIST OF REFERENCES

Alves, Chris JO2, “JDISS: When You Need It Now!” All Hands, Unclassified, August 1996.


JDISS Basic Operator Course (JBOC) v2.0 Student Guide, Joint Intelligence Training Activity, Pacific (JITAP), Unclassified, April 1996.

JDISS Program Management Office (PMO), ONI-71D, DSN 294-5072, Commercial (301) 669-5072.

Joint Intelligence Center (JIC), JDISS Brief, Unclassified, September 1995.


INITIAL DISTRIBUTION LIST

1. Defense Technical Information Center ................................................. 2
   8725 John J. Kingman Rd., STE 0944
   Fort Belvoir, Virginia 22060-6218

2. Dudley Knox Library ........................................................................... 2
   Naval Postgraduate School
   411 Dyer Road
   Monterey, California 93943-5101

3. Director, Training and Education ......................................................... 1
   MCCDC, Code C46
   1019 Elliot Road
   Quantico, Virginia 22134-5027

4. Director, Marine Corps Research Center .......................................... 2
   MCCDC, Code C40RC
   2040 Broadway Street
   Quantico, Virginia 22134-5107

5. Director, Studies and Analysis Division ............................................ 1
   MCCDC, Code C45
   3300 Russell Road
   Quantico, Virginia 22134-5130

6. Joint Intelligence Training Activity, Pacific (JITAP) ......................... 2
   Attn: LT Frank Nolan, JBOC Course Coordinator
   33470 Puerto Rico Street
   San Diego, California 92133-1847

7. Navy and Marine Corps Intelligence Training Center (NMITC) .......... 2
   Attn: LCDR Bill Ulman, N2O
   2088 Regulus Avenue
   Virginia Beach, Virginia 23461-2099

8. Professor Dan C. Boger, Code CC ......................................................... 1
   Naval Postgraduate School
   Monterey, California 93943

No. of copies

29
9. Professor Gary Porter, Code CC
   Naval Postgraduate School
   Monterey, California 93943

10. Marine Corps Representative
    Naval Postgraduate School
    Code 037, Bldg 234, HA-220
    699 Dyer Road
    Monterey, California 93943

11. Marine Corps Tactical Systems Support Activity
    Technical Advisory Branch
    Attn: Maj J. C. Cummiskey
    Box 555171
    Camp Pendleton, California 92055-5080

12. Major Marlon F. Brown, USMC
    13042 Cobble Lane
    Clifton, Virginia 22024